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Module: Accounts 

Whether you have an accountant in your internal team OR you do it yourself OR you have chosen to 
outsource it, the financial accounting process is almost always at the center any business 
management system (aka an ERP system). 

In ERP+, your accounting operations consists of 3 main transactions: 

• Sales Invoice: The bills that you raise to your Customers for the products or services you 
provide. 

• Purchase Invoice: Bills that your Suppliers give you for their products or services. 
• Journal Entries: For accounting entries, like payments, credit and other types. 
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1. Topics 

1.1 Setup and Opening 

1. Introduction 
2. Chart of Accounts 
3. Opening Balance 
4. Cost Center 
5. Fiscal Year 
6. Finance Book 
7. Accounts Settings 

1.2 Billing 

1. Sales Invoice 
2. Purchase Invoice 
3. Point of Sale POS Invoice 
4. Point of Sales 
5. Inter Company Invoices 
6. Recurring Orders and Invoices 
7. Credit Note 
8. Debit Note 

1.3 Journals and Payments 

1. Journal Entry 
2. Payments 
3. Payment Request 
4. Payment Terms 
5. Payment Entry 
6. Advance Payment Entry 
7. Reverse Journal Entry 
8. Inter Company Journal Entry 

1.4 Tools 

1. Bank Reconciliation 
2. Payment Reconciliation 
3. Period Closing Voucher 
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1.5 Reports 

1. Credit Limit 
2. Accounting Reports 
3. Accounts Receivable 

1.6 Pricing and Taxes 

1. Item Wise Taxation 
2. Tax Withholding Category 
3. Exchange Rate Revaluation 
4. Tax Withholding 
5. Pricing Rule 
6. Tax Rule 

1.7 Advanced 

1. Multi-Currency Accounting 
2. Deferred Revenue 
3. Bank Guarantee 
4. Loyalty Program 
5. Budgeting 
6. Auto Repeat 
7. Subscription 

1.8 Shareholder Management 

1. Shareholder 
2. Share Transfer 
3. Share Ledger 
4. Share Balance  
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2. Articles 

2.1 Record Entries 

1. Difference Entry Button 
2. Freeze Accounting Entries 
3. Post Dated Cheque Entry 
4. Adjust Withhold Amount Payment Entry 
5. Bulk Payment Entry 

2.2 Account Operations 

1. Changing Parent Account 
2. Withdrawing Salary from Owners Equity Account 
3. Common Receivable Account 
4. Freeze Account 
5. Round Off Account Validation 

2.3 Advanced 

1. What ss The Differences of Total and Valuation in Tax and Charges? 
2. Types in Tax Template 
3. Manage Foreign Exchange Difference 
4. How to Freeze Accounting Ledger? 
5. Managing Transactions in Multiple-Currency 

2.4 Other 

1. Tracking Project Profitability Using Cost Center 
2. Update Stock Option in Sales Invoice 
3. Exchange Rate Field Frozen 
4. Fiscal Year Creation 
5. How to Customize Cash Flow Report? 
6. How to Manage Subscriptions With ERP+? 

2.5 Reports and Errors 

1. Purchase Invoice Account Type Error 
2. Fiscal Year Error 
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1. Introduction 
2. Chart of Accounts 
3. Opening Balance 
4. Cost Center 
5. Fiscal Year 
6. Finance Book 
7. Accounts Settings 
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1. Introduction: Accounting Entries 

The concept of accounting is explained with an example given below: We will take a "Tea Stall" 
as a company and see how to book accounting entries for the business. 

• Mama (The Tea-stall owner) invests Rs 25000 to start the business. 

Analysis: Mama invested 25000 in company, hoping to get some profit. In other words, 
company is liable to pay 25000 to Mama in the future. So, account "Mama" is a liability account 
and it is credited. Company's cash balance will be increased due to the investment, "Cash" is 
an asset to the company and it will be debited. 

• The company needs equipment (Stove, teapot, cups etc.) and raw materials (tea, sugar, 
milk etc.) immediately. He decides to buy from the nearest general store "Super Bazaar" 
who is a friend so that he gets some credit. Equipment cost him 2800 and raw materials 
worth of 2200. He pays 2000 out of total cost 5000. 

Analysis: Equipment are "Fixed Assets" (because they have a long life) of the company and raw 
materials "Current Assets" (since they are used for day-to-day business), of the company. So, 
"Equipment" and "Stock in Hand" accounts have been debited to increase the value. He pays 
2000, so "Cash" account will be reduced by that amount, hence credited and he is liable to pay 
3000 to "Super Bazaar" later, so Super Bazaar will be credited by 3000. 

• Mama (who takes care of all entries) decides to book sales at the end of the everyday, so 
that he can analyze daily sales. At the end of the very first day, the tea stall sells 325 cups 
of tea, which gives net sales of Rs. 1575. The owner happily books his first day sales. 

Analysis: Income has been booked in "Sales of Tea" account which has been credited to 
increase the value and the same amount will be debited to "Cash" account. Let’s say, to make 
325 cups of tea, it costs Rs. 800, so "Stock in Hand" will be reduced (Cr) by 800 and expense will 
be booked in "Cost of goods sold" account by same amount. 

At the end of the month, the company paid the rent amount of stall (5000) and salary of one 
employee (8000), who joined from the very first day. 

Booking Profit 
As month progress, company purchased more raw materials for the business. After a month he 
books profit to balance the "Balance Sheet" and "Profit and Loss Statements" statements. 
Profit belongs to Mama and not the company hence it’s a liability for the company (it has to pay 
it to Mama). When the Balance Sheet is not balanced i.e. Debit is not equal to Credit, the profit 
has not yet been booked. To book profit, the following entry has to be made: 

Explanation: Company's net sales and expenses are 40000 and 20000 respectively. So, company 
made a profit of 20000. To make the profit booking entry, "Profit or Loss" account has been 
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debited and "Capital Account" has been credited. Company's net cash balance is 44000 and 
there are some raw materials available worth 1000 rupees. 
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2. Chart of Accounts 

The Chart of Accounts forms the blueprint of your organization. The overall structure of your 
Chart of Accounts is based on a system of double entry accounting that has become a standard 
all over the world to quantify how a company is doing financially. 

The Chart of Accounts helps you to answer: 

• What is your organization worth? 
• How much debt have you taken? 
• How much profit are you making (and hence paying tax)? 
• How much are you selling? 
• What is your expense break-up? 

You may note that as a business manager, it is very valuable to see how well your business is 
doing. 

Tip: If you can’t read a Balance Sheet (It took me a long time to figure this out) it's a good 
opportunity to start learning about this. It will be worth the effort. You can also take the help of 
your accountant to setup your Chart of Accounts. 

Financial statements for your company are easily viewable in ERP+. You can view financial 
statements such as Balance Sheet, Profit and Loss statement and Cash flow statement. 

An Example of various financial statement are given below: 

Cash Flow Report 
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Profit and Loss Report 
 

 

Balance Sheet Report 
 

 

To edit your Chart of Accounts in ERP+ go to: Accounts > Setup > Chart of Accounts 

Chart of Accounts is a tree view of the names of the Accounts (Ledgers and Groups) that a 
Company requires to manage its books of accounts. ERP+ sets up a simple chart of accounts for 
each Company you create, but you have to modify it according to your needs and legal 
requirements. For each company, Chart of Accounts signifies the way to classify the accounting 
entries, mostly based on statutory (tax, compliance to government regulations) requirements. 

Let us understand the main groups of the Chart of Accounts. 
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Balance Sheet Accounts 
The Balance Sheet has Application of Funds (/assets) and Sources of Funds (Liabilities) that 
signify the net-worth of your company at any given time. When you begin or end a financial 
period, all the Assets are equal to the Liabilities. 

Accounting: If you are new to accounting, you might be wondering, how can Assets be equal to 
Liabilities? That would mean the company has nothing of its own. That’s right. All the 
“investment” made in the company to buy assets (like land, furniture, machines) is made by the 
owners and is a liability to the company. If the company would want to shut down, it would 
need to sell all the assets and pay back all the liabilities (including profits) to the owners, leaving 
itself with nothing. 

All the accounts under this represent an asset owned by the company like "Bank Account", 
"Land and Property", "Furniture" or a liability (funds that the company owes to others) like 
"Owners funds", "Debt" etc. 

Two special accounts to note here are Accounts Receivable (money you have to collect from 
your customers) and Accounts Payable (money you have to pay to your suppliers) under Assets 
and Liabilities respectively. 

Profit and Loss Accounts 
Profit and Loss is the group of Income and Expense accounts that represent your accounting 
transactions over a period. 

Unlike Balance sheet accounts, Profit and Loss accounts (or PL accounts) do not represent net 
worth (/assets), but rather represent the amount of money spent and collected in servicing 
customers during the period. Hence at the beginning and end of your Fiscal Year, they become 
zero. 

In ERP+ it is easy to create a Profit and Loss analysis chart. An example of a Profit and Loss 
analysis chart is given below: 
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(On the first day of the year you have not made any profit or loss, but you still have assets, hence 
balance sheet accounts never become zero at the beginning or end of a period) 

Groups and Ledgers 
There are two main kinds of Accounts in ERP+ - Group and Ledger. Groups can have sub-groups 
and ledgers within them, whereas ledgers are the leaf nodes of your chart and cannot be further 
classified. 

Accounting Transactions can only be made against Ledger Accounts (not Groups) 

Info: The term "Ledger" means a page in an accounting book where entries are made. There is 
usually one ledger for each account (like a Customer or a Supplier). 
Note: An Account “Ledger” is also sometimes called as Account “Head”. 
 

 

Account Number 
A standard chart of accounts is organized according to a numerical system. Each major 
category will begin with a certain number, and then the sub-categories within that major 
category will all begin with the same number. For example, if assets are classified by numbers 



| Accounts | 1.1 Setup and Opening 
 

starting with the digit 1000, then cash accounts might be labeled 1100, bank accounts might be 
labeled 1200, accounts receivable might be labeled 1300, and so on. A gap between account 
numbers is generally maintained for adding accounts in the future. 

You can assign a number while creating an account from Chart of Accounts page. You can also 
edit a number from account record, by clicking "Update Account Number" button. On updating 
account number, system renames the account name automatically to embed the number in 
the account name. 

Other Account Types 
In ERP+, you can also specify more information when you create a new Account, this is there to 
help you select that particular account in a scenario like Bank Account or a Tax Account and has 
no effect on the Chart itself. 

Explanation of account types: 

• Bank: The account group under which bank account will be created. 
• Cash: The account group under which cash account will be created. 
• Cost of Goods Sold: The account to book the accumulated total of all costs used to 

manufacture / purchase a product or service, sold by a company. 
• Depreciation: The expense account to book the depreciation of the fixed assets. 
• Expenses Included in Valuation: The account to book the expenses (apart from direct 

material costs) included in landed cost of an item/product, used in Perpetual Inventory. 
• Fixed Asset: The account to maintain the costs of fixed assets. 
• Payable: The account which represents the amount owed by a company to its creditors. 
• Receivable: The account which represents the amount owed to a company by its debtors. 
• Stock: The account group under which the warehouse account will be created. 
• Stock Adjustment: An expense account to book any adjustment entry of stock/inventory. 

Generally, it comes at the same level of Cost of Goods Sold. 
• Stock Received but Not Billed: A temporary liability account which holds the value of 

stock received but not billed yet and used in Perpetual Inventory. 

Creating / Editing Accounts 
To create new Accounts, explore your Chart of Accounts and click on an Account group under 
which you want to create the new Account. On the right side, you will see an option to “Open” 
or “Add Child” a new Account. 
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Option to create will only appear if you click on a Group (folder) type Account. There you need 
to enter account name, account number and some more optional details. 

ERP+ creates a standard structure for you when the Company is created but it is up to you to 
modify or add or remove accounts. 

Typically, you might want to create Accounts for 

• Travel, salaries, telephone, etc. under Expenses. 
• Value Added Tax (VAT), Sales Tax, etc. under Current Liabilities. 
• Product Sales, Service Sales, etc. under Income. 
• Building, machinery, furniture, etc. under Fixed Assets. 
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3. Updating Opening Balance in Accounts 

If you are a new company you can start using ERP+ accounting module by going to chart of 
accounts. However, if you are migrating from a legacy accounting system like Tally or a Fox Pro 
based software, we recommend that you start using accounting in a new financial year, but you 
could start midway too. To setup your accounts, you will need the following for the “day” you 
start using accounting in ERP+: 

• Opening capital accounts - like your shareholder’s (or owner’) capital, loans, bank 
balances on that day. 

• List of outstanding sales and purchase invoices (Payables and Receivables). 

If you were using another accounting software before, firstly you should close financial 
statements in that software. The closing balance of the accounts should be updated as an 
opening balance in the ERP+. Before starting to update opening balance, ensure that your Chart 
of Accounts has all the Accounts required. 

Opening entry is only for Balance Sheet accounts and not for the Accounts in the Profit and Loss 
statement. 

• For all assets (excluding Accounts Receivables): This entry will contain all your assets 
except the amounts you are expecting from your Customers against outstanding Sales 
Invoices. You will have to update your receivables by making an individual entry for each 
Invoice (this is because, the system will help you track the invoices which are yet to be 
paid). You can credit the sum of all these debits against the Temporary Opening account. 

• For all liabilities: Similarly, you need to pass a Journal Entry for your Opening Liabilities 
(except for the bills you have to pay) against Temporary Opening account. 

Opening Entry 
Step 1: New Journal Entry 
To open new Journal Entry, go to: Explore > Accounts > Journal Entry 

Step 2: Entry Type 
If Entry Type is selected as Opening Entry, all the Balance Sheet Accounts will be auto-fetched 
in the Journal Entry. 

 

Step 3: Posting Date 
Select Posting Date on which Accounts Opening Balance will be updated. 
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Step 4: Enter Debit/Credit Value 
For each Account, enter opening value in the Debit or Credit column. As per the double entry 
valuation system, Total Debit value in an entry must be equal to Total Credit value. 

 

Step 5: Is Opening 
Set field Is Opening as Yes. 

 

Step 6: Save and Submit 
After enter opening balance for each account, Save and Submit Journal Entry. To check if 
Opening Balance for an account is updated correctly, you can check Trial Balance report. 

Selecting Accounts Manually 
If your Balance Sheet has many Accounts, then updating Account Opening balance from single 
Journal Entry can lead to performance issues. In such a scenario, you can multiple Journal 
Entries to update opening balance in all the Accounts. 

If you are updating account opening balance in few accounts at a time, you can use Temporary 
Opening account for balancing purpose. In the standard chart of accounts, a Temporary 
Opening Account is auto-created under Assets. 
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In the Journal Entry, manually select an Account for which opening balance is to be updated. 
For each Account, enter opening balance value in the Debit or Credit column, based on its 
Account Type (Asset or Liability). 

For example, if you want to update balance in bank accounts, create Journal Entry as following. 

 

Once all your invoices are entered, your Temporary Opening account will have a balance of 
zero! 

Trial Balance 
After completing the accounting entries, the trial balance report will look like the one given 
below: 
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Stock Opening 
To track stock balance in the Chart of Account, an Account is created for each Warehouse. 

Chart of Accounts > Assets > Current Asset > Stock Assets > (Warehouse Account) 

 

To update stock opening balance, create Stock Reconciliation entry. Based on the valuation of 
items' update in the Warehouse, balance will be updated in the Warehouse account. 

Fixed Asset Opening 
Opening balance for the fixed asset account should be updated via Journal Entry. Assets which 
are not fully depreciated should be added in the Asset master. For adding Assets in your 
possession, ensure to check Is Existing Asset field. 

Outstanding Payables and Receivables 
After opening Journal Entries are made, you will need to enter the Sales Invoice and Purchase 
Invoice that is yet to be paid. 

Since you have already booked the income or expense on these invoices in the previous period, 
select Temporary Opening in the “Income” and “Expense” accounts. 
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Note: Make sure to set each invoice as “Is Opening”! 

If you don’t care what items are in that invoice, just make a dummy item entry in the Invoice. 
Item code in the Invoice is not necessary, so it should not be such a problem. 

You can also do this quickly using the Opening Invoice Creation Tool 

To use this tool, just type "Opening Invoice" in the search bar and select the Opening Invoice 
Creation Tool 

Here, select the company and type of invoice (sales or purchase) and add a line item for each 
invoice you want to create. 
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4. Cost Center 

Your Chart of Accounts is mainly designed to provide reports to the government and tax 
authorities. Most businesses have multiple activities like different product lines, market 
segments, areas of business, etc. that share some common overheads. They should ideally have 
their own structure to report, whether they are profitable or not. For this purpose, there is an 
alternate structure, called the Chart of Cost Centers. 

Cost Center 
You can create a tree of Cost Centers to represent your business better. Each Income / Expense 
entry is also tagged against a Cost Center. If you allow cost center in entry of balance sheet 
account is checked under Account Settings, system will allow user to tag entry in Balance Sheet 
Account against a Cost Center. 

For example, if you have two types of sales: 

• Walk-in Sales 
• Online Sales 

You may not have shipping expenses for your walk-in customers, and no shop- rent for your 
online customers. If you want to get the profitability of each of these separately, you should 
create the two as Cost Centers and mark all sales as either "Walk-in" or "Online". Mark your all 
your purchases in the same way. 

Thus, when you do your analysis you get a better understanding as to which side of your 
business is doing better. Since ERP+ has an option to add multiple Companies, you can create 
Cost Centers for each Company and manage it separately. 

Chart of Cost Centers 
To setup your Chart of Cost Centers go to: Accounts > Setup > Chart of Cost Centers 
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5. Fiscal Year 

A fiscal year is also known as a financial year or a budget year. It is used for calculating financial 
statements in businesses and other organizations. The fiscal year may or may not be the same 
as a calendar year. For tax purposes, companies can choose to be calendar-year taxpayers or 
fiscal-year taxpayers. In many jurisdictions, regulatory laws regarding accounting and taxation 
require such reports once per twelve months. However, it is not mandatory that the period 
should be a calendar year (that is, 1 January to 31 December). 

A fiscal year usually starts at the beginning of a quarter, such as April 1, July 1 or October 1. 
However, most companies' fiscal year also coincides with the calendar year, which starts 
January 1. For the most part, it is simpler and easier that way. For some organizations, there 
are advantages in starting the fiscal year at a different time. For example, businesses that are 
seasonal might start their fiscal year on July 1 or October 1. A business that has most of its 
income in the fall and most of its expenses in the spring might also choose to start its fiscal year 
on October 1. That way, they know what their income will be for that year, and can adjust their 
expenses to maintain their desired profit margins. 

To set the Fiscal Year as default, click on the 'Default' button. 

In case you have multiple companies sharing the same Fiscal Year, you can add it into the grid 
as shown below. 
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6. Finance Book 

A Finance Book is a book against which all the accounting entries are booked. You can have 
multiple finance books, for example one book for tax authorities and another for stockholders. 

This is useful if you have to report depreciation and other values in different ways based on 
regulatory requirements. You can also use this to post alternate balance sheets for your internal 
reporting. 

In ERP+, Finance Book is not a mandatory setup. But if you choose to create multiple finance 
books, then you can make entries against a specific finance book by selecting that book in 
Journal Entry. If a Finance Book field is blank in Journal Entry that means the entry will be 
available in all finance books. 

Many a times, for fixed asset depreciation, company use different depreciation method 
(Straight Line / Written Down Value / Double Declining Balance) for different finance book. In 
ERP+, you can setup different depreciation schedule for each finance book and auto 
depreciations will booked against that finance book only. 
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7. Accounts Settings 

 

• Accounts Frozen Up to: Freeze accounting transactions up to a specified date, nobody can 
make / modify entry except specified role. 

• Role Allowed to Set Frozen Accounts & Edit Frozen Entries: Users with this role are allowed 
to set frozen accounts and create / modify accounting entries against frozen accounts. 

• Credit Controller: Role that is allowed to submit transactions that exceed credit limits set. 
• Make Payment via Journal Entry: If checked, from invoice, if user choose to make 

payment, this will open the journal entry instead of payment entry 
• Allow Cost Center in Entry of Balance Sheet Account: If checked, system will allow user to 

tag entry in Balance Sheet Account against a Cost Center. 
• Unlink Payment on Cancellation of Invoice: If checked, system will unlink the payment 

against the invoice. Otherwise, it will show the link error. 
• Allow Stale Exchange Rate: This should be unchecked if you want ERP+ to check the age 

of records fetched from Currency Exchange in foreign currency transactions. If it is 
unchecked, the exchange rate field will be read-only in documents. 

• Stale Days: The number of days to use when deciding if a Currency Exchange record is 
stale. E.g.: If Currency Exchange records are to be updated every day, the Stale Days 
should be set as 1. 



 

 

 

 

 

 

 

 

 

1.2 Topic: Journals and Payments 
 

1. Journal Entry 
2. Payments 
3. Payment Request 
4. Payment Terms 
5. Payment Entry 
6. Advance Payment Entry 
7. Reverse Journal Entry 
8. Inter Company Journal Entry 
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1. Journal Entry 

All types of accounting entries other than Sales Invoice and Purchase Invoice are made using 
the Journal Entry. A Journal Entry is a standard accounting transaction that affects multiple 
Accounts and the sum of debits is equal to the sum of credits. 

To create a Journal Entry, go to: Accounts > Company and Accounts > Journal Entry > New 

 

In a Journal Entry, you must select. 

• Type of Voucher from the drop down. 
• Add rows for the individual accounting entries. In each row, you must specify: 

o The Account that will be affected 
o The amount to Debit or Credit 
o The Cost Center (if it is an Income or Expense) 
o Against Voucher: Link it to a voucher or invoice if it affects the “outstanding” amount 

of that invoice. 
o Is Advance: Select “Yes” if you want to make it selectable in an Invoice. Other 

information in case it is a Bank Payment or a bill. 

Difference 
The “Difference” field is the difference between the Debit and Credit amounts. This should be 
zero if the Journal Entry is to be “Submitted”. If this number is not zero, you can click on “Make 
Difference Entry” to add a new row with the amount required to make the total as zero. 
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2. Common Entries 

A look at some of the common accounting entries that can be done via Journal Voucher. 

Expenses (non-accruing) 
Many times, it may not be necessary to accrue an expense, but it can be directly booked against 
an expense Account on payment. For example, a travel allowance or a telephone bill. You can 
directly debit Telephone Expense (instead of your telephone company) and credit your Bank 
on payment. 

• Debit: Expense Account (like Telephone expense) 
• Credit: Bank or Cash Account 

Bad Debts or Write Offs 
If you are writing off an Invoice as a bad debt, you can create a Journal Voucher similar to a 
Payment, except instead of debiting your Bank, you can debit an Expense Account called Bad 
Debts. 

• Debit: Bad Debts Written Off 
• Credit: Customer 

Note: There may be regulations in your country before you can write off bad debts. 
Depreciation 
Depreciation is when you write off certain value of your assets as an expense. For example, if 
you have a computer that you will use for say 5 years, you can distribute its expense over the 
period and pass a Journal Entry at the end of each year reducing its value by a certain 
percentage. 

• Debit: Depreciation (Expense) 
• Credit: Asset (the Account under which you had booked the asset to be depreciated) 

Note: There may be regulations in your country that define by how much amount you can 
depreciate a class of Assets. 
Credit Note 
"Credit Note" is made for a Customer against a Sales Invoice when the company needs to adjust 
a payment for returned goods. When a Credit Note is made, the seller can either make a 
payment to the customer or adjust the amount in another invoice. 

• Debit: Sales Return Account 
• Credit: Customer Account 
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Debit Note 
"Debit Note" is made for a Supplier against a Purchase Invoice or accepted as a credit note from 
supplier when a company returns goods. When a Debit Note is made, the company can either 
receive a payment from the supplier or adjust the amount in another invoice. 

• Debit: Supplier Account 
• Credit: Purchase Return Account 

Excise Entry 
When a Company buys good from a Supplier, company pays excise duty on these goods to 
Supplier. And when a company sells these goods to Customers, it receives excise duty. 
Company will deduct payable excise duty and deposit balance in Govt. account. 

• When a Company buys goods with Excise duty: 
o Debit: Purchase Account 
o Debit: Excise Duty Account 
o Credit: Supplier Account 

• When a Company sells goods with Excise duty: 
o Debit: Customer Account 
o Credit: Sales Account 
o Credit: Excise Duty Account 

Payments 

Payment can be made against following transactions. 

1. Sales Invoice. 
2. Purchase Invoice. 
3. Sales Order (Advance Payment) 
4. Purchase Order (Advance Payment) 

In ERP+, there is two options through which user can capture the payment 

1. Payment Entry (Default). 
2. Journal Entry. 

  



| Accounts | 1.2 Journals and Payment 
 

3. Payment Request 

Payment Request is sent via Email and will contain a link to a Payment Gateway if setup. You 
can create payment request via Sales Order or Sales Invoice. 

Create Payment Request via Sales Order  

 

Create payment Request via Sales Invoice  

 

Select appropriate Payment Gateway Account on Payment Request. Account head specified on 
payment gateway will considered to create journal entry. 

Note: Invoice/Order currency and Payment Gateway Account currency should be same. 
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Notify Customer 

You can notify customer from Payment Request with print format. If customer contact email is 
mentioned, it will automatically fetch email. If not so you can set Email Address on Payment 
Request. 

 

Request Mail 

 

4. Payment Terms 
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You can save your business' payment terms on ERP+ and include it in all documents in the 
sales/purchase cycle and ERP+ will make all the proper general ledger entries accordingly. 

The documents you can attach Payment Terms to are: - Sales Invoice - Purchase Invoice - Sales 
Order - Purchase Order - Quotation 

Note that the introduction of Payment Terms removes "Credit Days" and "Credit Days Based 
On" fields in Customer/Supplier master. Payment Term contains the same information and 
makes it more flexible to use. 

Navigate to the Payment Term list page and click "New". Accounts > Payment Term > New 
Payment Term 

Payment Term has the following fields:  

Payment Term Name: (optional) The name for this Payment Term. 
Due Date Based On: The basis by which the due date for the Payment Term is to be calculated. 
There are three options: - Day(s) after invoice date: Due date should be calculated in days with 
reference to the posting date of the invoice - Day(s) after the end of the invoice month: Due date 
should be calculated in days with reference to the last day of the month in which the invoice 
was created - Month(s) after the end of the invoice month: Due date should be calculated in 
months with reference to the last day of the month in which the invoice was created 
Invoice Portion: (optional) The portion of the total invoice amount for which this Payment 
Term should be applied. Value given will be regarded as percentage i.e. 100 = 100% 
Credit Days: (optional) The number of days or month credit is allowed depending on the option 
chosen in the Due Date Based On field. 0 means no credit allowed. 
Description: (optional) A brief description of the Payment Term. 

Payment Terms in Converted Documents 

When converting or copying documents in the sales/purchase cycle, the attached Payment 
Term(s) will not be copied. The reason for this is because the copied information might no 
longer be true. For example, a Quotation is created for a service costing $1000 on January 1 
with payment term of "N 30" (Net payable within 30 days) and then sent to a customer. On the 
quotation, the due date on the invoice will be January 30. Let's say the customer agrees to the 
quotation of January 20 and you decide to make an invoice from the Quotation. If the Payment 
Terms from the Quotation is copied, the due date on the invoice will still wrongly read January 
30. This issue also applies for recurring documents. 

This does not mean you have manually set Payment Terms for every document. If you want the 
Payment Terms to be copiable, make use of Payment Terms Template. 

Payment Terms Template 
Payment Terms Template tells ERP+ how to populate the table in the Payment Terms Schedule 
section of the sales/purchase document. 
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You should use it if you have a set of standard Payment Terms or if you want the Payment 
Term(s) on a sales/purchase document to be copiable. 

To create a new Payment Terms Template, navigate to the Payment Term Template creation 
form: Accounts > Payment Terms Template > New Payment Terms Template 

Payment Term: (optional) The name for this Payment Term. 

Due Date Based On: The basis by which the due date for the Payment Term is to be calculated. 
There are three options: - Day(s) after invoice date: Due date should be calculated in days with 
reference to the posting date of the invoice - Day(s) after the end of the invoice month: Due date 
should be calculated in days with reference to the last day of the month in which the invoice 
was created - Month(s) after the end of the invoice month: Due date should be calculated in 
months with reference to the last day of the month in which the invoice was created 

Invoice Portion: (optional) The portion of the total invoice amount for which this Payment 
Term should be applied. Value given will be regarded as percentage i.e 100 = 100% 

Credit Days: (optional) The number of days or month credit is allowed depending on the option 
chosen in the Due Date Based On field. 0 means no credit allowed. 

Description: (optional) A brief description of the Payment Term. 

Add as many rows as needed but make sure that the sum of the values in the Invoice Portion 
fields in all populated rows equals 100. 

How to Add Payment Terms to Documents 
You can add Payments Terms in the "Payment Terms Schedule" section of the Document. Each 
row in the table represents a portion of the document's grand total. The table collects the 
following information: 

Payment Term: (optional) The name of the Payment Term document you require. If this is 
added, the data from the selected Payment Term will be used to populate the remaining 
columns in the row. 
Description: (optional) Description of the Payment Term. 
Due Date: (optional) The due date for the portion of the invoice. Set this value only if you did 
not specify anything in the Payment Term column. 
Invoice Portion: The percentage portion of the document represented in each row. 
Payment Amount: The amount due from the portion of the invoice represented by each row. 

5. Payment Entry 

Payment Entry can be made against following transactions. 

1. Sales Invoice. 
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2. Purchase Invoice. 
3. Sales Order (Advance Payment) 
4. Purchase Order (Advance Payment) 
5. Expense Claim 

Step 1: Make Payment 
On submitting a document against which Payment Entry can be made, you will find Make 
Payment button. 

 

Step 2: Mode of Payment 
In the Payment Entry, select Mode of Payment (e.g.: Bank, Cash, Wire Transfer). In the Mode of 
Payment master, default Account can be set. This default payment Account will fetch into 
Payment Entry. 

 

Step 3: Payment Amount 
Enter actual payment amount received from the Customer or paid to the Supplier or Employee. 
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Step 4: Allocate Amount 
If creating Payment Entry for the Customer, Payment Amount will be allocated against Sales 
Invoice. 

 

On the same lines, when creating Payment Entry for a Supplier, Payment Amount will be 
allocated against Purchase Invoice. 

You Entry can be created directly from Account > Payment Entry > New. In the new entry, on 
selection of the Party (Customer/Supplier), all the outstanding Invoices and open Orders will 
be fetched for party. The Payment Amount will be auto-allocated, preferably against invoice. 

Step 5: Deductions 
When making payment entry, there could be some difference in the actual payment amount 
and the invoice outstanding. This difference could be due to rounding error, or change in the 
currency exchange rate. You can set an Account here where this difference amount will be 
booked. 
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Step 6: Submit 
Save and Submit Payment Entry. On submission, outstanding will be updated in the Invoices. 

 

If payment entry was created against Sales Order or Purchase Order, field Advance Paid will be 
updated in them. when creating Payment invoice against those transactions, Payment Entry 
will auto-update in that Invoice, so that you can allocate invoice amount against advance 
payment entry. 

For incoming payment, accounts posting will be done as following. 

• Debit: Bank or Cash Account 
• Credit: Customer (Debtor) 

For outgoing payment: 

• Debit: Supplier (Creditor) 
• Credit: Bank or Cash Account 

Multi-Currency Payment Entry 
ERP+ allows you maintain accounts and invoicing in the multiple currency. If invoice is made in 
the party currency, Currency Exchange Rate between companies’ base currency and party 
currency is also entered in the invoice. When creating Payment Entry against that invoice, you 
will again have to mention the Currency Exchange Rate at the time of payment. 
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Since Currency Exchange Rate is fluctuating all the time, it can lead to difference in the payment 
amount against invoice total. This difference amount can be booked in the Currency Exchange 
Gain/Loss Amount. 

 

Payments can also be made independent of invoices by creating a new Payment Entry. 

Internal transfer 
Following internal transfers can be managed from the Payment Entry. 

1. Bank - Cash 
2. Cash - Bank 
3. Cash - Cash 
4. Bank - Bank 
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Difference between Payment Entry and Journal Entry? 

1. Journal Entry requires understanding of which Account will get Debited or Credited. In 
the Payment Entry, it is managed in the backend, hence simpler for the User. 

2. Payment Entry is more efficient in managing payment in the foreign currency. 
3. Journal Entry can still be used for: 

o Updating opening balance in an Accounts. 
o Fixed Asset Depreciation entry. 
o For adjusting Credit Note against Sales Invoice and Debit Note against Purchase 

Invoice, in case there is no payment happening at all. 

Payment Entries are used if a cheque is printed  



| Accounts | 1.2 Journals and Payment 
 

6. Journal Entry 

To make payment using journal entry, check below steps 

Step 1: Activate Payment via Journal Entry 
Go to Accounts Settings > checked Make Payment via Journal Entry 

 

Step 2: Make Payment 
On submitting a document against which Journal Entry can be made, you will find Make 
Payment button. 

 

Step 3: Journal Entry 
Save and submit the journal entry to record the payment against the invoice 
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Managing Outstanding Payments 
In most cases, apart from retail sales, billing and payments are separate activities. There are 
several combinations in which these payments are done. These cases apply to both sales and 
purchases. 

• They can be upfront (100% in advance). 
• Post shipment. Either on delivery or within a few days of delivery. 
• Part in advance and part on or post-delivery. 
• Payments can be made together for a bunch of invoices. 
• Advances can be given together for a bunch of invoices (and can be split across invoices). 

ERP+ allows you to manage all these scenarios. All accounting entries (GL Entry) can be made 
against a Sales Invoice, Purchase Invoice or Payment Entry of advance payment (in special 
cases, an invoice can be made via a Sales Invoice too). 

The total outstanding amount against an invoice is the sum of all the accounting entries that 
are made “against” (or are linked to) that invoice. This way you can combine or split payments 
in Payment Entry to manage the scenarios. 
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7. Advance Payment Entry 

Payment done by the customer before accepting delivery of the product is an Advance 
Payment. For Orders of high value, the business houses expect to receive advance. 

For Example: Consider a customer- Jane D’Souza placing an order for a double bed costing 
$10000 She is asked to give some advance before the furniture house begins work on her order. 
She gives them $5000 in cash. 

Once Sales Order or Purchase Order is submitted, you will find option to create Advance 
Payment entry against it. To directly create Advance Payment Entry, Go to: Accounts > 
Documents > Journal Entry > New Journal Entry 

Select a Voucher Type based on a mode in which advance payment is made. 

Since the customer has given $5000 as cash advance, it will be recorded as a credit entry against 
the customer. To balance it with the debit entry [as per the Double accounting system] enter 
$5000 as debit against the company's cash account. In the row "Is Advance" click 'Yes'. 

Journal Entry -Advance Entry 

 

Double Entry Accounting 
Double entry bookkeeping is a system of accounting in which every transaction has a 
corresponding positive and negative entry: debits and credits. Every transaction involves 
a debit entry in one account and a credit entry in another account. This means that every 
transaction must be recorded in two accounts; one account will be debited because it receives 
value and the other account will be credited because it has given value. 
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Transaction and Difference Entry 

 

Save and submit the Journal Entry. If this document is not saved it will not be pulled in other 
accounting documents. 

When you make a new Sales Invoice for the same customer, mention the advance in the Sales 
Invoice Form. 

To link the Sales Invoice to the Journal Entry which mentions the advance payment entry, click 
on ‘Get Advances Received’. Allocate the amount of advance in the advances table. The 
accounting will be adjusted accordingly. 

Receive Advance 

 

Save and submit the Sales Invoice. 
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8. Reverse Journal Entry 

In any submitted Journal Entry, there is a dedicated button to reverse a Journal Entry. On 
clicking the button, the system creates a new Journal Entry by reversing debit and credit 
amount against all the accounts. 
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9. Inter Company Journal Entry 

You can also create Inter Company Journal Entry if you are making transactions with multiple 
Companies. You can select the Accounts which you wish to use in the Inter Company 
transactions. Just go to: Accounts > Company and Accounts > Chart Of Accounts 

Select the Account which you would like to set as an Internal Account for the transaction, and 
check the Inter Company Account checkbox. It can now be used for Inter Company Journal 
Entry Transactions. 

 

You need to do the same for all the Companies' Accounts which you want to use for Inter 
Company Journal Entry transactions. 

Now, to create an Inter-Company Journal Entry go to: Accounts > Company and Accounts > 
Journal Entry > New 

 

In the Journal Entry, you must select, 

• Type of Voucher - Inter Company Journal Entry. 
• Add rows for the individual accounting entries. In each row, you must specify: 
o The Internal account that will be affected. 
o The amount to Debit or Credit. 
o The Cost Center (If it is an Income or Expense). 

On submitting the Journal Entry, you will find a button on the top right corner, Make Inter 
Company Journal Entry. 
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Click on the button, you will be asked to select the Company against which you wish to create 
the linked Journal Entry. 

 

On selecting the Company, you will be routed to another Journal Entry where the relevant fields 
will be mapped, i.e. Company, Voucher Type, Inter Company Journal Entry Reference etc. 
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Select the Internal accounts for the Company selected and submit the Journal Entry, make sure 
the total Debit and Credit Amounts are same as the previously created Journal Entry's total 
Credit and Debit Amounts respectively. 

You can also find the reference link at the bottom, which will be added in both the linked 
Journal Entries and will be removed if any of the Journal Entries are cancelled. 



 

 

 

 

 

 

 

 

 

 

 

1.3 Topic: Billing 
 

1. Sales Invoice 
2. Purchase Invoice 
3. Point of Sale (POS) 
4. Point of Sale Invoice 
5. Inter Company Invoices 
6. Recurring Orders and Invoices 
7. Credit Note 
8. Debit Note 
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1. Sales Invoice 

A Sales Invoice is a bill that you send to your customers, against which the customer processes 
the payment. Sales Invoice is an accounting transaction. On submission of Sales Invoice, the 
system updates the receivable and books income against a Customer Account. 

You can create a Sales Invoice directly from: Accounts > Billing > Sales Invoice > New Sales 
Invoice 

or you can Make a new Sales Invoice after you submit the Delivery Note. 

 

Accounting Impact 
All Sales must be booked against an “Income Account”. This refers to an Account in the 
“Income” section of your Chart of Accounts. It is a good practice to classify your income by type 
(like product income, service income etc.). The Income Account must be set for each row of the 
Items table. 

Tip: To set default Income Accounts for Items, you can set it in the Item or Item Group. 

The other account that is affected is the Account of the Customer. That is automatically set from 
“Debit To” in the heading section. 

You must also mention the Cost Centers in which your Income must be booked. Remember that 
your Cost Centers tell you the profitability of the different lines of business or product. You can 
also set a default Cost Center in the Item master. 

Accounting entries (GL Entry) for a typical double entry “Sale”: 
When booking a sale (accrual): 
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Debit: Customer (grand total) Credit: Income (net total, minus taxes for each 
Item) Credit: Taxes (liabilities to be paid to the government) 

To see entries in your Sales Invoice after you “Submit”, click on “View Ledger”. 
Dates 
Posting Date: The date on which the Sales Invoice will affect your books of accounts i.e. your 
General Ledger. This will affect all your balances in that accounting period. 

Due Date: The date on which the payment is due (if you have sold on credit). This can be 
automatically set from the Customer master. 

Recurring Invoices 
If you have a contract with a Customer where you bill the Customer on a monthly, quarterly, 
half-yearly or annual basis, you can check the “Recurring Invoice” box. Here you can fill in the 
details of how frequently you want to bill this Invoice and the period for which the contract is 
valid. 

ERP+ will automatically create new Invoices and mail it to the Email Addresses you set. 

Automatically Fetching Item Batch Numbers 
If you are selling an item from a Batch, ERP+ will automatically fetch a batch number for you if 
"Update Stock" is checked. The batch number will be fetched on a First Expiring First Out (FEFO) 
basis. This is a variant of First in First Out (FIFO) that gives highest priority to the soonest to 
expire Items. 

Note that if the first batch in the queue cannot satisfy the order on the invoice, the next batch 
in the queue that can satisfy the order will be selected. If there is no batch that can satisfy the 
order, ERP+ will cancel its attempt to automatically fetch a suitable batch number. 

POS Invoices 
Consider a scenario where retail transaction is carried out. For e.g.: A retail shop. If you check 
the Is POS checkbox, then all your POS Profile data is fetched into the Sales Invoice and you 
can easily make payments. Also, if you check the Update Stock the stock will also update 
automatically, without the need of a Delivery Note. 
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Billing Timesheet with Project 
If you want to bill employees working on Projects on hourly basis (contract based), they can fill 
out Timesheets which consists their billing rate. When you make a new Sales Invoice, select the 
Project for which the billing is to be made, and the corresponding Timesheet entries for that 
Project will be fetched. 

"Pro Forma" Invoice 
If you want to give an Invoice to a Customer to make a payment before you deliver, i.e. you 
operate on a payment first basis, you should create a Quotation and title it as a “Pro-forma 
Invoice” (or something similar) using the Print Heading feature. 

“Pro Forma” means for formality. Why do this? Because if you book a Sales Invoice it will show 
up in your “Accounts Receivable” and “Income”. This is not ideal as your Customer may or may 
not decide to pay up. But since your Customer wants an “Invoice”, you could give the Customer 
a Quotation (in ERP+) titled as “Pro Forma Invoice”. This way everyone is happy. 

This is a fairly common practice. 
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2. Purchase Invoice 

Purchase Invoice is the exact opposite of your Sales Invoice. It is the bill that your Supplier sends 
you for products or services delivered. Here you accrue expenses to your Supplier. Making a 
Purchase Invoice is very similar to making a Purchase Order. 

To make a new Purchase Invoice: type "new purchase invoice" into the search bar then select 
"New Purchase Invoice" from the drop down or click on “Make Purchase Invoice” in Purchase 
Order or Purchase Receipt. 

You can also create a Purchase Invoice from: Accounts > Billing > Purchase Invoice > New 
Purchase Invoice 

 

The concept of “Posting Date” is again same as Sales Invoice. “Bill No” and “Bill Date” helps to 
track the bill number as set by your Supplier for reference. 

Is Paid option 
The Is Paid checkbox should be checked if there is a part or full payment on the invoice at 
posting date. 

Update Stock 
The Update Stock checkbox should be checked if you want ERP+ to automatically update your 
inventory. Consequently, there will be no need for a Delivery Note. 

Accounting Impact 
Like in Sales Invoice, you have to enter an Expense or an Asset account for each row in your 
Items table. This helps to indicate if the Item is an Asset or an Expense. You must also enter a 
Cost Center. These can also be set in the Item master. 

The Purchase Invoice will affect your accounts as follows: 
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Accounting entries (GL Entry) for a typical double entry “purchase”: 

Debits: 

• Expense or Asset (net totals, excluding taxes) 
• Taxes (/assets if VAT-type or expense again). 

Credits: 
• Supplier 

Accounting Treatment When Is Paid is checked 

If Is Paid is checked, ERP+ will also make the following accounting entries: 

Debits: Supplier 

Credits: Bank/Cash Account 
To see entries in your Purchase Invoice after you “Submit”, click on “View Ledger”. 

Is purchase an “Expense” or an “Asset”? 
If the Item is consumed immediately on purchase, or if it is a service, then the purchase 
becomes an “Expense”. For example, a telephone bill or travel bill is an “Expense” - it is already 
consumed. 

For inventory Items, that have a value, these purchases are not yet “Expense”, because they 
still have a value while they remain in your stock. They are “Assets”. If they are raw-materials 
(used in a process), they will become “Expense” the moment they are consumed in the process. 
If they are to be sold to a Customer, they become “Expense” when you ship them to the 
Customer. 

Deducting Taxes at Source 
In many countries, the law may require you to deduct taxes, while paying your suppliers. These 
taxes could be based on a standard rate. Under this type of schemes, typically if a Supplier 
crosses a certain threshold of payment, and if the type of product is taxable, you may have to 
deduct some tax (which you pay back to your government, on your Supplier’s behalf). 

To do this, you will have to make a new Tax Account under “Tax Liabilities” or similar and credit 
this Account by the percent you are bound to deduct for every transaction. 

For more help, please contact your Accountant! 

Hold Payments for A Purchase Invoice 
There are two ways to put a purchase invoice on hold: - Date Span Hold - Explicit Hold 

Explicit Hold 
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Explicit hold holds the purchase invoice indefinitely. To do it, in the "Hold Invoice" section of 
the purchase invoice form, simply check the "Hold Invoice" checkbox. In the "Reason For 
Putting On Hold" text field, type a comment explaining why the invoice is to be put on hold. 

If you need to hold a submitted invoice, click the "Make" drop down button and click "Block 
Invoice". Also add a comment explaining why the invoice is to be put on hold in the dialog that 
pops up and click "Save". 

Date Span Hold 

Date span hold holds the purchase invoice until a specified date. To do it, in the "Hold Invoice" 
section of the purchase invoice form, check the "Hold Invoice" checkbox. Next, input the 
release date in the dialog that pops up and click "Save". The release date is the date that the 
hold on the document expires. 

After the invoice has been saved, you can change the release date by clicking on the "Hold 
Invoice" drop down button and then "Change Release Date". This action will cause a dialog to 
appear. 

 

Select the new release date and click "Save". You should also enter a comment in the "Reason 
for Putting on Hold" field. 

Take note of the following: - All purchases that have been placed on hold will not be included 
in a Payment Entry's references table - The release date cannot be in the past. - You can only 
block or unblock a purchase invoice if it is unpaid. - You can only change the release date if the 
invoice is unpaid. 
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3. Point of Sale Invoice 

The one-screen point-of-sale software, for the one-stop-shop retail business. It does everything 
your store needs, right from POS billing, to purchasing, to customer relationship management. 

 

Offline POS 
In the retails business, invoicing needs to done very quickly, hence should less dependency. In 
ERP+, you can create POS Invoices, even when not connected to the internet. 
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4. Point of Sale Invoice 

For retail operations, the delivery of goods, accrual of sale and payment all happens in one 
event, that is usually called the “Point of Sale” (POS). 

Offline POS 
In the retails business, invoicing needs to done very quickly, hence should less dependency. In 
the ERP+, you can create POS Invoices, even when not connected to the internet. 

POS Invoices created in the offline mode will be saved locally in the browser. If internet 
connection is lost which creating POS Invoice, you will still be able can proceed forward. Once 
internet connection is available again, offline invoices will be synced, and pushed onto your 
ERP+ account. To learn more on how POS Invoices can be created when offline. 

POS Profile 
In ERP+ all Sales and Purchase transactions, like Sales Invoice, Quotation, Sales Order, 
Purchase Order etc. can be edited via the POS. There two steps to Setup POS: 

1. Enable POS View via (Setup > Customize > Feature Setup) 
2. Create a POS Profile record 

Different sections of the POS 

• Update Stock: If this is checked, Stock Ledger Entries will be made when you “Submit” 
this Sales Invoice thereby eliminating the need for a separate Delivery Note. 

• In your Items table, update inventory information like Warehouse (saved as default), 
Serial Number, or Batch Number if applicable. 

• Update Payment Details like your Bank / Cash Account, Paid amount etc. 
• If you are writing off certain amount. For example, when you receive extra cash as a result 

of not having exact denomination of change, check on ‘Write off Outstanding Amount’ 
and set the Account. 

Customer 
In POS, user can select the existing customer during making an order or create the new 
customer. This feature works in the offline mode also. User can also add the customer details 
like contact number, address details etc. on the form. The customer which has been created 
from the POS will be synced when the internet connection is active. 
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Adding an Item 
At the billing counter, the retailer needs to select Items which the consumer buys. In the POS 
interface you can select an Item by two methods. One, is by clicking on the Item image and the 
other, is through the Barcode / Serial No. 

Select Item - To select a product click on the Item image and add it into the cart. A cart is an 
area that prepares a customer for checkout by allowing to edit product information, adjust 
taxes and add discounts. 

Barcode / Serial No - A Barcode / Serial No is an optical machine-readable representation of 
data relating to the object to which it is attached. Enter Barcode / Serial No in the box as shown 
in the image below and pause for a second, the item will be automatically added to the cart. 

 

Tip: To change the quantity of an Item, enter your desired quantity in the quantity box. These 
are mostly used if the same Item is purchased in bulk. 
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If your product list is very long, use the Search field, type the product name in Search box. 

Removing an Item from the Cart: Select row in the cart and click on delete button in the numeric 
keypad 

 

Set Qty as zero to remove Item from the POS invoice. There are two ways to remove an Item. 

o If Item's Qty is 1, click on a minus sign to make it zero. 
o Manually enter 0(zero) quantity. 

Make Payment 
After all the Items and their quantities are added into the cart, you are ready to make the 
Payment. Payment process is divided into 3 steps - 

1. Click on “Make Payment” to get the Payment window. 
2. Select your “Mode of Payment”. 
3. Click on “Pay” button to Save the document. 
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Submit the document to finalize the record. After the document is submitted, you can either 
print or email it directly to the customer. 

Write off Amount 
Outstanding amount can be written off from the POS, user has to enter the amount under write 
off field on the payment screen. 

 

System books the write off amount into the ledger which has selected on the POS Profile. 
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Change Amount 
POS calculate the extra amount paid by the customer, which user can return from the cash 
account. User has to set the account for the change amount on the POS profile. 

 

Offline Records 
All the records from the POS stores into the browser's local storage and sync submitted records 
after every minute of the interval if system is connected to internet. User can view the offline 
records by clicking on Menu > View Offline Records 
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Accounting entries (GL Entry) for a Point of Sale: 
Debits: 

• Customer (grand total) 
• Bank / Cash (payment) 

Credits: 

• Income (net total, minus taxes for each Item) 
• Taxes (liabilities to be paid to the government) 
• Customer (payment) 
• Write Off (optional) 
• Account for Change Amount (optional) 

To see entries after “Submit”, click on “View Ledger”. 

Email 
User can send email from the POS, after submission of an order, user has to click on menu > 
email  

After sync of an order, email sent to the customer with the print of the bill in the attachment 

POS Closing Voucher 
At the end of its shift, the cashier can close his/her POS by creating a POS Closing Voucher. Click 
on the menu and select "Close the POS" 

Select the period, your POS Profile and your user to retrieve all sales registered. 
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Enter the collected amount for each mode of payment. If you notice any difference between the 
theoretical amount and the collected amount, create a difference posting. 
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5. Inter Company Invoices 

Along with creating Purchase Invoices or Sales Invoices for a single company, you can create 
inter-linked invoices for multiple companies. 

Such as, you can create a Purchase Invoice for a company say 'Company ABC', and create a 
Sales Invoice against this Purchase Invoice for a company say 'Company XYZ' and link them 
together. 

To create Inter Company Invoices as mentioned in the above process, you need to follow the 
below steps: 

• Go to the Customer list, select the customer which you would want to choose for the inter-
linked invoices, enable the checkbox, Is Internal Customer as shown below: 

 

• Along with that, add the company which the Customer represents, i.e. the company for 
which the Sales Invoice will be created. 

• Next, fill up the child table Allowed to Transact With as shown in the image and add the 
company against which you will be creating a Purchase Invoice, which will be linked with 
the Sales Invoice created using this Customer. 

• Easy, right? Now, you need to follow the similar procedure for setting up a Supplier for 
inter-linked invoices. And, in the Represents Company field, add the company which you 
added in the child table Allowed to Transact with for the Customer. 

• And, in the child table Allowed to Transact with for the Supplier, add the company which 
the Customer represents or against which you are going to make an inter-linked Purchase 
Invoice. You can refer the below image to avoid any confusion. 
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o Now, create a new Sales Invoice, fill up the fields, and remember to select the Customer 
who is an internal customer and company which the Customer represents. 

o Submit the Invoice. 

 

o Under the Make button dropdown, you will find a link Inter Company Invoice, on clicking 
the link, you will be routed to a new Purchase Invoice form page. 

o Here, the supplier and company will be auto-fetched depending on the company you 
selected in the Sales Invoice. Remember: There can only be a single Internal Supplier or 
Customer per company. 

o Submit the invoice, done! Now, both the invoices are inter-linked. Also, on cancelling any 
of the invoices, the link will break as well. 

You can follow the same process to create a Purchase Invoice and then an inter-linked Sales 
Invoice from the submitted Purchase Invoice. 
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6. Recurring Orders and Invoices 

If you have a contract with a Customer where you bill the Customer on a monthly, quarterly, 
half-yearly or annual basis, you should use recurring feature in orders and invoices. 

Scenario: 
Subscription for your hosted ERP+ account requires yearly renewal. We use Sales Order for 
generating proforma invoices. To automate proforma invoicing for renewal, we set original 
Sales Order as recurring. Recurring proforma invoice is created automatically just before 
customer's account is about to expire, and requires renewal. This recurring Proforma Invoice is 
also emailed automatically to the customer. 

Feature of setting document as recurring is available in Sales Order, Sales Invoice, Purchase 
Order and Purchase Invoice. 

Option to set document as recurring will be visible only after submission. Recurring is last 
section in document. Check Is Recurring to set document as recurring. 

From Date and To Date: This defines contract period with the customer. 
Repeat on the Day of Month: If recurring type is set as Monthly, then it will be day of the month 
on which recurring invoice will be generated. 
End Date: Date after which auto-creation of recurring invoice will be stopped. 
Notification Email Address: Email Addresses (separated by comma) on which recurring 
invoice will be emailed when auto-generated. 
Recurring ID: Recurring ID will be original document id which will be linked to all 
corresponding recurring document. For example, original Sales Invoice's id will be updated into 
all recurring Sales Invoices. 
Recurring Print Format: Select a print format to define document view which should be 
emailed to customer. 
Exception Handling: 
In a situation where recurring invoice is not created successfully, user with System Manager role 
is notified about it via email. Also, the document on which recurring event failed, "Is Recurring" 
field is unchecked for it. This means system doesn't try creating recurring invoice for that 
document again. 

Failure in creation of recurring invoice could be due to multiple reasons like wrong Email 
Address mentioned in the Email Notification field in Recurring section etc. 

On receipt of notification, if cause of failure is fixed (like correcting Email Address) within 24 
hours, then recurring invoice will be generated automatically. If issue is not fixed within the said 
time, then document should be created for that month/year manually. 
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7. Credit Note 

A credit note is a document sent by a seller to the customer, notifying that a credit has been 
made to their account against the goods returned by the buyer. 

A credit note is issued for the value of goods returned by the customer, it may be less than or 
equal to total amount of the order. 

How to make credit note in ERP+ 

The user can make a credit note against the sales invoice or they can directly make credit note 
from the sales invoice without reference, go to module Accounts > Sales Invoice > New > 
Manually enabled Is Return checkbox 

Note: For credit note set the negative quantity while adding the item 
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8. Debit Note 

A debit note is a document sent by a buyer to a seller, or in other words, a purchaser to a vendor 
while returning goods received on credit. This notifies that a debit has been made to their 
accounts. 

A debit note is issued for the value of the goods returned. In some cases, sellers are seen sending 
debit notes which should be treated as just another invoice. 

How to make debit note in ERP+ 

The user can make a debit note against the purchase invoice or they can directly make debit 
note from the purchase invoice without reference Go to module Accounts > Purchase Invoice > 
New > Manually enabled Is Return checkbox 

 

Note: For debit note set the negative quantity while adding the item. 



 

 

 

 

 

 

 

 

 

1.4 Topic: Pricing and Taxes 
 

1. Item Wise Taxation 
2. Tax Withholding Category 
3. Exchange Rate Revaluation 
4. Tax Withholding 
5. Pricing Rule 
6. Tax Rule 
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1. Itemized Taxation 

In the sales and purchase transactions, you can apply taxes and other charges on the items. For 
the ease of applying taxes, you can fetch values from the Sales Taxes and Charges master. Taxes 
and charges are applied equally on all the items. For example, if tax GST 16% is added in the 
Taxes and Charges table in Sales Order, then it will be applied on all the items in that Sales 
Order. However, if you need to have different tax rate applied on some of the items, following 
is how you should setup Items and Sales Taxes and Charges Template master in your ERP+ 
account. 

Let's assume that we are creating a Sales Order. We have Sales Taxes and Charges Template 
master for GST 16%. Out of all the Sales Items, on one item, only 5% GST will be applied, while 
one more item is exempted from the tax. 

Step 1: Mention Tax Applicable in the Item master 
Items on which differential tax rate is applied, you should mention the tax, that you would apply 
in the Sales Order, for that item in the Item master itself and change the Tax Rate (in this case 
5). Item master has tax table where you can list taxes which will be applied on it. 

Tax rate mentioned in the item master gets preference over tax rate entered in the transactions. 
Here is the example of Item on which 5% GST is applied only. 

 

For the item which is exempted from GST totally, mention 0% as tax rate in the Item master. 

Note: For Item Tax to work, you need to ensure that the Tax accounts set in Item Tax table (with 
changed tax rates) in Item master are part of the default Sales / Purchase Tax Template. 
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Step 2: Setup Taxes and Other Charges 
In Sales Taxes and Charges Template master, select GST 16% account and mention Tax Rate as 
16. This tax rate will be applied on all the Items selected in the Sales Order, unless specific Tax 
Rate is defined in the Item master. 

 

If you want to have tax rate always applied from the Item master, then you should update Rate 
for the tax account as zero in the Taxes and Charges Template master. 

Step 3: Tax Calculation in transaction 
In the Sales Order, we have selected many Items. For the items mentioned in blue, tax rate is 
applied based on tax rate mentioned in the taxes table. For the items highlighted in red, tax rate 
has fetched for them from the respective item master. 
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Please note that item's tax rate will be pulled from the item master only if you have selected 
same tax account (GST 16% in this case) in both Item master and in Sales Order under Taxes 
and Charges section. 
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2. Tax Withholding Category 

Tax Withholding Category is simply Tax Deducted at Source. According to this, a person 
responsible for making payments are required to deduct tax at source at prescribed rates. 
Instead of receiving tax on your income from you at a later date, the govt wants the payers to 
deduct tax beforehand and deposit it with the government. 

To create a Tax Withholding Category, go to: Accounts > Taxes > Tax Withholding Category > 
New 

 

In a Tax Withholding Category, you must select. 

• A unique name for the tax category (for example, "Section 194C Individual"). 
• The name or description should be filled in the Category Name field (for example, 

"Payment to Contractors (Single / Aggregate)"). 
• Add rows for the rates applicable in current fiscal year. In each row, you must specify: 

o The current Fiscal Year. 
o The rate to be applied on the invoice amount. 
o The threshold for a single invoice. 
o The threshold for the sum of the amount of all invoices. 

• Add rows for the Account head to be used (company wise). In each row, you must specify: 
o The name of the Company. 
o The Account head where the tax amount will be credited to. 

Note: Let’s say a rate of 5% will be applicable on invoice where Single threshold is 20,000 and 
Cumulative threshold is 30,000. If an invoice is created with a grand total of 20,000 then the 
single threshold will be triggered and a 5% tax would be charged. But if the invoice amount 
totaled up to be 15,000 then no tax will be charged as it didn't cross the threshold. If again an 
invoice is created with a total of 15,000 then although it didn't cross the Single threshold, 
charges will be deducted since the sum of last invoice and this invoice adds up to be 30,000 
which is equal to the specified Cumulative threshold. 
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Supplier 
Select the Tax Category that needs to be applied on the Supplier. 

 

 

Purchase Invoice 
If the Supplier has the tax withholding field set, then upon selecting that supplier, a checkbox 
will become visible to select whether to apply tax or not. 
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How it works? 
Setting up: Firstly, we need to create a Tax Withholding Category like: 

 

Go to Supplier master and select the tax category created. 
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Creating Invoice: Go to Purchase Invoice and select the supplier from above. 

 

 

Saving the invoice, automatically calculates tax and appends it in the taxes table. 
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In case of Cumulative threshold, lets create an invoice with a total of 15,000 and submit it. 
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Now, let’s create another invoice same as the above. Although the invoice amount didn't cross 
the Single threshold, we see that tax has been charged. This is because the previous and the 
current invoice adds up to be 30,000 which exceeds the Cumulative threshold and hence tax 
based on the rate provided in the Tax Withholding Category are applied accordingly. 

 

Note: On submitting the invoice, three GL Entry are created i.e. first for debit from the expense 
head, second for credit in Creditors account and third for credit in the account selected in Tax 
Withholding Category. 
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3. Exchange Rate Revaluation 

In ERP+, you can make accounting entries in multiple currency. For example, if you have a bank 
account in foreign currency, you can make transactions in that currency and system will show 
bank balance in that specific currency only. 

Setup 
To get started with multi-currency accounting, you need to assign accounting currency in 
Account record. You can define Currency from Chart of Accounts while creating Account. 

 

You can also assign / modify the currency by opening specific Account record for existing 
Accounts. 
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Exchange Rate Revaluation 
Exchange Rate Revaluation feature is for dealing the situation when you have a multiple 
currency accounts in one company's chart of accounts 

Step 1: Set the 'Unrealized Exchange / Gain Loss Account' field in Company Doctype. This 
account is to balance the difference of total credit and total debit. 

 

1. Select the Company. 
2. Click the Get Entries button. It shows the accounts which having different currency as 

compare to 'Default Currency' in Company DocType. It will fetch the new exchange rate 
automatically if not set in Currency Exchange DocType for that currency else it will fetch 
the 'Exchange Rate' from Currency Exchange DocType 
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On Submitting, 'Make Journal Entry' button will appear. This will create a journal entry for the 
Exchange Rate Revaluation. 

 

 

Tax Withholding 

Withholding tax is a tax that is deducted by the payer of the income. This withholding tax is also 
called retention tax. Under withholding tax, the taxable amount is deducted at source by the 
payer i.e. the payer of the income is liable to deduct the withholding tax before making payment 
to the payee. The withholding tax sounds similar to Tax deducted at source (TDS). 

tax withholding can be setup based on Supplier. 

To use Tax Withholding feature in ERP+, first, you need to create Tax Withholding Category 
record. Here, you can mention percent of tax withheld and threshold amount (if any). Here, the 
threshold amount means tax will be deducted only if the order value is greater than or equal to 
the threshold value. You also need to link related accounts to the Tax Withholding Category 
record. 
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To enable Tax Withholding for any Supplier, you need to mention applicable percent against 
tax withholding category. 
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4. Pricing Rule 

Pricing Rule is a master where you can define rules based on which discount is applied to 
specific Customer or Supplier. 

Scenario: 
Following are the few cases which can be addressed using Pricing Rule. 

1. As per the promotional sale policy, if customer purchases more than 10 units of an item, 
he enjoys 20% discount. 

2. For Customer "XYZ", selling price for the specific Item should be updated as ###. 
3. Items categorized under specific Item Group has same selling or buying price. 
4. Customers belonging to specific Customer Group should get ### selling price, or % of 

Discount on Items. 
5. Supplier categorized under specific Supplier Group should have ### buying rate applied. 

To have %Discount and Price List Rate for an Item auto-applied, you should create Pricing Rules 
for it. 

Pricing Rule master has two sections: 

1. Applicability Section: 
In this section, conditions are set for the application of Pricing Rule. When transaction meets 
condition as specified in this section, Rate or Discount as specified in the Pricing Rule will be 
applied. You can set condition on following values. 

Applicable On: 

 

If you want Pricing Rule to be applied on all the items, select based on Item Group. For value, 
select All Item Group (parent Item Group). 

Applicable For: 
Applicability option will be updated based on our selection for Selling or Buying or both. You 
can set applicability on one of the following masters. 
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Quantity: 
Specify minimum and maximum qty of an item when this Pricing Rule should be applicable. 

 

2. Application: 
Using Price List Rule, you can ultimately define rate or %discount to be applied on an item. 

 

Rate 
Rate or Discount specified in the Pricing Rule will be applied only if above applicability rules are 
matched with values in the transaction. Rate mentioned in Pricing Rule will be given priority 
over item's Price List rate. 
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Discount Percentage 
Discount Percentage can be applied for a specific Price List. To have it applied for all the Price 
List, %Discount field should be left blank. 

 

If %Discount is to be applied on all Price Lists, then leave Price List field blank. 

Validity 
Enter “From” and “To” date between which this Pricing Rule will be applicable. This will be 
useful if creating Pricing Rule for sales promotion exercise available for certain days. 

 

Priority 
If two or more Pricing Rules are found based on same conditions, Priority is applied. Priority is 
a number between 0 to 20 while default value is zero (blank). Higher number means it will take 
precedence if there are multiple Pricing Rules with same conditions. 
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Disable 
Check to Disable Pricing Rule. 

 

Add Margin 
Using pricing rule user can add margin on the sales transactions 

For example: User want to add 10% margin on the supplier price list at the time of sales 

1. Make Price List: Create price list for supplier and create item price against the price list. 
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2. Make Pricing Rule 
Create pricing rule for the item against which supplier rate has created 

 

3. Make Invoice 
System apply the margin rate on the item price on selection of an item. 
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5. Tax Rule 

You can define which Tax Template must be applied on a Sales / Purchase transaction using 
Tax Rule. 

 

You can define Tax Rules for Sales or Purchase Taxes. While making a Transaction the system 
will select and apply tax template based on the tax rule defined. The system selects Tax Rule 
with maximum matching Filters. 

Let us consider a scenario to understand Tax Rule Better. Suppose we define 2 Tax Rules as 
below. 
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Here Tax Rule 1 has Billing Country as India and Tax Rule 2 has Billing Country as United 
Kingdom 

Now supposed we try to create a Sales Order for a customer whose default Billing Country is 
India, system shall select Tax Rule 1. In case the customers Billing Country was United Kingdom, 
the system would have selected Tax Rule 2. 

 



 

 

 

 

 

 

 

 

 

1.5 Topic: Tools 
 

1. Bank Reconciliation 
2. Payment Reconciliation 
3. Period Closing Voucher 
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1. Bank Reconciliation 

If you are receiving payments or making payments via cheques, the bank statements will not 
accurately match the dates of your entry, this is because the bank usually takes time to “clear” 
these payments. Also, you may have mailed a cheque to your Supplier and it may be a few days 
before it is received and deposited by the Supplier. In ERP+ you can synchronize your bank 
statements and your Journal Entries using the transaction dates, see section 2 below. 

What is a Bank Reconciliation Statement? 
The Bank Reconciliation Report provides the difference between the bank balance shown in an 
organization's bank statement, as provided by the bank against amount shown in the 
companies Chart of Accounts. 

This is what a Bank Reconciliation statement looks like: 

 

In the report, check whether the field 'Balance as per bank' matches the Bank Account 
Statement. If it is matching, it means that Clearance Date is correctly updated for all the bank 
entries. If there is a mismatch, it is because of bank entries for which Clearance Date is not yet 
updated. 

How to Update Bank Transaction Dates 

1. Go to Accounts > Banking and Payments > Update Bank Transaction Dates. 
2. Select your Bank Account. 
3. Select a from and to date. 
4. You can choose to include reconciled entries and POS transactions. 
5. Click on the Get Payment Entries button. 
6. Now you will get all the “Bank Voucher” type entries. 
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7. In each of the entries, on the right most column, update the “Clearance Date” field and 
click on the “Update Clearance Date” button. 

By doing this you will be able to sync your bank statements and entries into the system. 

 

Types of reconciliation tools 

ERP+ has two reconciliation tools: 

1. A manual reconciliation tool allowing to set clearance dates against payment entries, 
sales invoice payments or journal entries 

2. A semi-automatic reconciliation tool allowing to clear bank transactions against 
payments entries, sales and purchase invoices payments, journal entries or expense 
claims. 

Manual Bank Reconciliation Tool 
To view this report, go to Accounts > Banking and Payments > Bank Reconciliation Statement. 
In the report, check whether the field 'Balance as per bank' matches the Bank Account 
Statement. If it is matching, it means that Clearance Date is correctly updated for all the bank 
entries. If there is a mismatch, it's because Clearance Date is not yet updated for the bank 
entries. 

Semi-automatic Bank Reconciliation Tool 
Bank statement upload 

You can upload a Bank Statement in CSV or XLX format into ERP+ using the Bank Reconciliation 
tool. 

1. Download a bank statement from your bank's website 
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Make sure you have at least the date, the debit/credit and the currency on every row of your 
bank statement. 

2. Configure the import format in the Bank DocType 

 

3. Upload your file into ERP+ 

Bank Account Synchronization 

You can use Plaid (see ERP+ Integrations section) to automatically synchronize your bank account 
with ERP+. All your bank transactions will be automatically imported into ERP+. 

Once all your bank transactions are imported into ERP+, you can reconcile them with your existing 
payments. If it finds a payment that appear to match with the selected bank transaction, ERP+ will 
propose you a corresponding payment. 

If that payment matches, just click on reconcile to reconcile it with this bank transaction. If ERP+ 
doesn't propose you any payment, you can always select the corresponding payment manually. You 
can also create a new payment or invoice directly from the bank reconciliation dashboard. 
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2. Payment Reconciliation 

In complex scenarios, especially in the capital goods industry, sometimes there is no direct link 
between payments and invoices. You send invoices to your Customers and your Customer 
sends you block payments or payments based on some schedule that is not linked to your 
invoices. 

In such cases, you can Match Payments with Invoices. 

How to Match Payments with Invoices 

1. Go to Accounts > Banking and Payments > Match Payments with Invoices. 
2. Select a company if there are multiple. 
3. Select a Party Type and select the Party. 
4. Select the Bank/Cash account against which the payments need to be reconciled. 
5. If you want to filter the records, select a date range for the invoices. 
6. Click on the Get Unreconciled Entries button. 
7. This will fetch all un-linked Payment Entry and Sales Invoices from that Customer in a 

table. 
8. Delete any unwanted entries. 
9. Select the Invoice Number. 
10. Amount is the amount paid by the party, Allocated Amount is the amount you want to 

allocate for the reconciliation. 
11. Click on Reconcile. 

You will get a message that says 'Amount allocated successfully' 

 

3. Period Closing Voucher 
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At the end of every year or (quarterly or maybe even monthly), after completing auditing, you 
can close your books of accounts. This means that you make all your special entries like: 

• Depreciation 
• Change in value of Assets 
• Defer taxes and liabilities 
• Update bad debts 

Then book your Profit or Loss. 

By doing this, your balance in your Income and Expense Accounts becomes zero. You start a 
new Fiscal Year (or period) with a balanced Balance Sheet and fresh Profit and Loss account. In 
ERP+ after making all the special entries via Journal Entry for the current fiscal year, you should 
set all your Income and Expense accounts to zero via a Period Closing Voucher. 

How to create a Period Closing Voucher 

1. Go to: Accounts > Tools > Period Closing Voucher > New. 
2. Set a posting date. 
3. Select the account. 
4. Enter remarks. 
5. Save and Submit. 

The fields explained 

• Transaction Date will be Period Closing Voucher's creation date. 
• Posting Date will be when this entry should be executed. If your Fiscal Year ends on 31st 

December, then that date should be selected as Posting Date in the Period Closing 
Voucher. 

• Closing Fiscal Year will be a year for which you are closing your financial statement. 

 

The Period Closing Voucher will make accounting entries (GL Entry). This will make all your 
Income and Expense Accounts zero and transfer Profit/Loss balance to the Closing Account. 

You should select a liability account like Reserves and Surplus, or Any Revenue Reserve account 
or into Owners Capital account as Closing Account. 
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Note: If accounting entries are made in a closing fiscal year, even after Period Closing Voucher 
was created for that Fiscal Year, you should create another Period Closing Voucher. Later 
voucher will only transfer the pending P&L balance into Closing Account Head. 



 

 

 

 

 

 

 

 

 

1.6 Topic: Reports 
 

1. Credit Limit 
2. Accounting Reports 
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1. Credit Limit 

A credit limit is the maximum amount of credit that a financial institution or other lender will 
extend to a debtor for a particular line of credit. From an organization’s perspective, it is the 
maximum amount of credit which a customer gets on goods purchased. 

To set credit limit go to Customer – Master: Selling > Document > Customer 

 

Go to the 'CREDIT LIMIT' section and enter the amount in the field Credit Limit. 

If you leave CREDIT LIMIT as 0.00, it has no effect. 

In case a need arises to allow more credit to the customer as a good-will, the Credit Controller 
has access to submit order even if credit limit is crossed. 

To allow any other role to submit transactions by customers whose credit limit has expired, go 
to accounting settings and make changes. 

In the field Credit Controller, select the role who would be authorized to accept orders or raise 
credit limits of customers. 

To set credit limit at Customer Group Level go to Selling -> Customers -> Customer Group 

Go to the 'CREDIT LIMIT' field and enter the amount. If you leave CREDIT LIMIT as 0.00, it has no 
effect. 

To set credit limit at Company level go to Account -> Company 

Go to the 'ACCOUNT SETTINGS' section and enter the amount in the CREDIT LIMIT field. If you 
leave CREDIT LIMIT as 0.00, it has no effect. 

For 'CREDIT LIMIT' check functionality, Priority (High to Low) is as below 1) Customer 2) 
Customer Group 3) Company 
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Save the changes. 
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2. Accounting Reports 

General Ledger 
The General Ledger is a detail report for all transactions posted to each account and for every 
transaction there is a Credit and Debit account so it lists them all up. 

The report is based on the table GL Entry and can be filtered by many pre-defined filters like 
Account, Cost Centers, Party, Project and Period etc. This helps you to get a full update for all 
entries posted in a period against any account. The result can be grouped by Account, 
Voucher/Transaction and Party with opening and closing balances for each group. In case of 
multi-currency accounting, there is also an option to check the amounts in any other currency 
than company's base currency. 

 

Trial Balance 
A Trial Balance is an accounting report which lists account balances for all your Accounts 
(“Ledger” and “Group”) for any given reporting period. A company prepares a trial balance 
periodically, usually at the end of every reporting period. The general purpose of producing a 
trial balance is to ensure the entries in a company's bookkeeping system are mathematically 
correct. The totals of Debit and Credit columns must be same for any given period, to ensure 
the entries are correct. In ERP+, the report shows following columns: 

• Opening (Dr): Opening debit balance as on From Date 
• Opening (Cr): Opening credit balance as on From Date 
• Debit: Total Debited amount against the account between the selected period 
• Credit: Total Credited amount against the account between the selected period 
• Closing (Dr): Closing debit balance as on To Date 
• Closing (Cr): Closing credit balance as on To Date 
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There are some other options as well to include or exclude Period Closing Entries, show / hide 
accounts with zero balance and to show unclosed previous fiscal year's P&L (Income & 
Expenses) balances. All the figures in the report are shown in company's base currency. 

 

Party Wise Trail Balance 
Usually you might need to see the trail balance for your customers and suppliers. You can easily 
get for all of your customers or suppliers and also for individual. 

 

Balance Sheet 
A Balance Sheet is the financial statement of a company which states assets, liabilities and 
equity at a particular point in time. 
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The Balance Sheet in ERP+ gives you more flexibility to analysis your financial position. You can 
run the report across multiple year to compare values. You can check values for a specific 
Finance Book or Cost Center. You can also choose any other currency to display the balances. 

 

Profit and Loss Statement 
A Profit and Loss Statement is a financial statement which summarizes all the revenues and 
expenses in a given period. The report is also known as P&L Statement. 

In ERP+, you can run the report across multiple year / period to compare the values. You can 
also check values for a specific Finance Book, Project or Cost Center. You can also choose any 
other currency to display the balances. If you are running the report to see quarterly / monthly 
balances, you can choose whether you want to show accumulated balances or only for each 
period. 



| Accounts | 1.6 Reports 
 

 

Cash Flow Statement 
A Cash Flow is a financial statement which shows the incoming and outgoing of cash or cash-
equivalents for a company. It is used to analyze the liquidity position of the company. 
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Consolidated Financial Statements 
The report shows a consolidated view of Balance Sheet, Profit and Loss Statement and Cash 
Flow for a group company, by merging financial statements of all the subsidiary companies. It 
shows balances for all individual company and as well as accumulated balances for a group 
company. 

 

Accounts Receivable and Accounts Payable (AR / AP) 

These reports help you to track the outstanding number of Customers and Suppliers. It also 
provides ageing analysis i.e. a break-up of outstanding amount based on the period for which 
the amount is outstanding. 
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Sales and Purchase Register 
The Sales and Purchase Register report shows all the Sales and Purchase transactions for a 
given period with invoiced amount and tax details. In this report, each tax has a separate 
column, so you can easily get total taxes collected / paid for a period for each individual tax 
type, which helps to pay the taxes to government. 

 

Item wise Sales and Purchase Register 
The Item Wise Sales and Purchase Register report shows all the Sales and Purchase 
transactions for a given period with item rate, quantity, amount and tax details. In this report, 
taxes have a separate column, so you can easily get individual taxes for each individual item. 
From this report you can have a look of which items are sold or purchase most. 

 

Budget Variance 
In ERP+, you can assign expense budget for an expense account against any specific cost center. 
This report gives a comparison between budgeted and actual expenses and the variance (the 
difference between the two) in monthly / quarterly / yearly view. 
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GSTR-1 (India) 
The GSTR-1 report helps Indian users to file monthly return of outward supplies. This report 
shows all the sales transactions of the company in Govt specified format. The output of the 
report is changed based on the selected type of business (B2B, B2C Large, B2C Small, CDNR and 
Export). 

 

GSTR-2 (India) 
The GSTR-2 report helps Indian users to file monthly return of inward supplies. The report gives 
the details of all inward supplies of goods or services received during a month, in Govt specified 
format. 
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Sales or Purchase Invoice Trends 
Another very useful report is invoice trends, from this report you can easily get the trending 
items on monthly, quarterly, half yearly or yearly basis. You will get the idea of sales and 
purchase both in quantity and amount. 

 

Other Reports: 

• Ordered Items to Be Billed: The report shows the items which has been ordered by 
customers, against which Sales Invoice has not been created / partially been created. 

• Delivered Items to Be Billed: The items which has been delivered to the customers, but 
Sales Invoice has not been created / partially been created. 

• Purchase Order Items to Be Billed: The report shows the items which has been ordered 
from the suppliers, but Purchase Invoice has not been created / partially been created. 

• Received Items to Be Billed: The items which has been received from the suppliers, but 
Purchase Invoice has not been created / partially been created. 

• Customer Credit Balance: The report shows the credit limit, outstanding and credit 
balance for each customer. 

How to see Accounts Receivable report based on payment terms 

This report shows all the account receivables based on payment terms.  

Accounts Receivable report based on payment terms can be seen by navigating to: 
Accounts>Accounting Statements>Accounts Receivable 
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As seen in the example below outstanding amount against each payment term can be 
seen. Invoiced Amount shows each payment term amount and Paid Amount shows paid 
amount against each payment term. Payment against each term is allocated in FIFO order. 

 



 

 

 

 

 

 

 

 

 

1.7 Topic: Advanced 
 

1. Multi-Currency Accounting 
2. Deferred Revenue 
3. Bank Guarantee 
4. Loyalty Program 
5. Budgeting 
6. Auto Repeat 
7. Subscription 
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1. Multi-Currency Accounting 

In ERP+, you can make accounting entries in multiple currency. For example, if you have a bank 
account in foreign currency, you can make transactions in that currency and system will show 
bank balance in that specific currency only. 

Setup 
To get started with multi-currency accounting, you need to assign accounting currency in 
Account record. You can define Currency from Chart of Accounts while creating Account. 

 

You can also assign / modify the currency by opening specific Account record for existing 
Accounts. 
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For Customer / Supplier (Party), you can also define its billing currency in the Party record. If 
the Party's accounting currency is different from Company Currency, you should mention 
Default Receivable / Payable Account in that currency. 

 

Once you defined Currency in the Account and selected relevant accounts in the Party record, 
you are ready to make transactions against them. If Party account currency is different from 
Company Currency, system will restrict to make transaction for that party with that currency 
only. If account currency is same as Company Currency, you can make transactions for that 
Party in any currency. But accounting entries (GL Entries) will always be in Party Account 
Currency. 

You can change accounting currency in Party / Account record, until making any transactions 
against them. After making accounting entries, system will not allow to change the currency for 
both Party / Account record. 

In case of multi-company setup, accounting currency of Party must be same for all the 
companies. 

Exchange Rates 
When dealing with multiple currencies, ERP+ has the Currency Exchange module for managing 
exchange rates. It allows you to save the exchange rate quotes you require. 

For foreign currency transactions, ERP+ checks Currency Exchange for any matching record. If 
this fails, ERP+ will attempt to get the exchange rate quote from fixer.io. If this still fails, then 
the exchange rate will have to be entered manually. 

Exchange Rate Selection 
ERP+ automatically fetches the latest exchange rate available. 
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Transactions 
Sales Invoice 
In Sales Invoice, transaction currency must be same as accounting currency of Customer if 
Customer's accounting currency is other than Company Currency. Otherwise, you can select 
any currency in Invoice. On selection of Customer, system will fetch Receivable account from 
Customer / Company. The currency of receivable account must be same as Customer's 
accounting currency. 

Now, in POS, Paid Amount will be entered in transaction currency, instead of earlier Company 
Currency. Write Off Amount will also be entered in transaction currency. 

Outstanding Amount and Advance Amount will always be calculated and shown in Customer's 
Account Currency. 

 

Purchase Invoice 
Similarly, in Purchase Invoice, accounting entries will be made based on Supplier's accounting 
currency. Outstanding Amount and Advance Amount will also be shown in the supplier's 
accounting currency. Write Off Amount will now be entered in transaction currency. 

Journal Entry 
In Journal Entry, you can make transactions in different currencies. There is a checkbox "Multi 
Currency", to enable multi-currency entries. If "Multi-Currency" option selected, you will be 
able to select accounts with different currencies. 
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In Accounts table, on selection of foreign currency account, system will show Currency section 
and fetch Account Currency and Exchange Rate automatically. You can change / modify the 
Exchange Rate later manually. Debit / Credit amount should be entered in Account Currency, 
system will calculate and show the Debit / Credit amount in Company Currency automatically. 

 

Reports 
General Ledger 
In General Ledger, system shows debit / credit amount in both currency if filtered by an Account 
and Account Currency is different from Company Currency. 
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Accounts Receivable / Payable 
In Accounts Receivable / Payable report, system shows all the amounts in Party / Account 
Currency. 
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2. Deferred Revenue 

Deferred revenue, also known as unearned revenue, refers to advance payments a company 
receives for products or services that are to be delivered or performed in the future. 

The company that receives the prepayment records the amount as Deferred revenue on their 
balance sheet as a liability. Deferred revenue is a liability because it refers to revenue that has 
not been earned and represents products or services that are owed to a customer. As the 
product or service is delivered over time, it is recognized as revenue on the income statement. 

Deferred Revenue Use case 
The internet and broadcasting services providers offers subscription plans on quarterly or 
yearly basis. They take complete payment in advance from the customer for couple of months, 
but book income on monthly basis in their books of accounts. Following is how they should 
configure Deferred Revenue accounting in ERP+ to automate the process. 

Item 
In the Item master created for the subscription plan, under Deferred Revenue section, check 
field Enable Deferred Revenue. In this section, you can also select a Deferred Revenue account 
for this particular item and no. of months. 

 

Sales Invoice 
On creation of Sales Invoice for the Deferred Revenue Item, instead of posting in the Income 
Account, Deferred Revenue account is Credited by the sale amount. 
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Journal Entry 
Based on the From Date and To Date set in the Sales Invoice Item table, Journal Entries are 
created automatically at the end of each month. It debits the value from Deferred Revenue 
account and credits Income Account selected for an Item in the Sales Invoice. Following is the 
example of Income for the deferred Revenue Item is booked via multiple Journal Entries. 
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3. Bank Guarantee 

A Bank Guarantee is a guarantee from a lending institution such as a bank ensuring the 
liabilities of a debtor will be met. In other words, if the debtor fails to settle a debt, the bank 
covers it. A Bank Guarantee enables the customer, or debtor, to acquire goods, buy equipment 
or draw down loans, and thereby expand business activity. 

A client may ask you to provide a Bank Guarantee from a third party such as a bank. This 
guarantee is for a specified amount, which is usually a percentage of the total value of the 
contract. The Bank Guarantee is valid for a specified duration after which it expires and must 
be returned to you by the client. 

This document allows you to track Bank Guarantees given to clients. You can set Email Alerts 
as the Bank Guarantee expiry date approaches to remind yourself to get the Bank Guarantee 
back from your client. 
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4. Loyalty Program 

What is a Loyalty Program? 
A customer loyalty program is a structured and long-term marketing effort which provides 
incentives to repeat customers who demonstrate loyal buying behavior. Successful programs 
are designed to motivate customers in a business's target market to return often, make 
frequent purchases, and shun competitors. 
 
To create a Loyalty Program, go to: Accounts > Billing > Loyalty Program > New 

 

In a Loyalty Program, you must select. 

• Type of Program from the drop down. 
• From Date - to provide when to start considering this Program. 
• End Date - to provide till when should this Program's effect be considered. 
• Auto Opt-in to automatically select a Program when creating a new Customer. 
• Add rows for the Collection Tier. In each row, you must specify: 

o Tier name to be assigned to a Customer based on his eligibility. 
o Collection Factor - how much of an amount constitutes 1 loyalty point. 
o Minimum Spent - minimum transaction amount to be eligible for this tier. 
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Loyalty Point Entry 
 
Loyalty Point Entry acts as a log to give an overview about which Customer earned how many 
points across which Invoice. It holds the data Invoice and Customer. 

 

Customer 
 
Loyalty Program section in Customer master. 

 
Loyalty Point earned can be viewed in Customer's dashboard. 
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Earning Points 

• Firstly, a Loyalty Program needs to be created (as shown in the first screenshot). 
• Assign this Loyalty Program to a Customer. 
• Go to Sales Invoice > New and create an invoice for the Customer to whom you have 

assigned Loyalty Program. 
• For this example, an invoice is created with a grand total of 10000 INR and according to 

the Loyalty Program for a minimum spent of 10000 INR, the Silver Tier collection factor 
will be eligible and for each 1000 INR spent, the Customer will receive 1 point (hence the 
total point earned on this transaction is 10). 

• Upon submission of the invoice, Loyalty Point Entry will be created for this invoice (as 
shown above under Loyalty Program Entry section). 

• In the Loyalty Program upon minimum spent of 19000, Gold Tier would be eligible. So, if 
we were to duplicate our current invoice and submit it, the Customer will be 
automatically upgraded to Gold tier as his total expenditure under this current Loyalty 
Program has exceeded the minimum spent value for Gold tier collection factor (as his last 
invoice was 10000 INR and duplicated from that gives another invoice of 10000 INR, hence 
his total expenditure becomes 20000 INR). 

Note: The minimum spent in Loyalty Program does not mean a minimum value for a single 
invoice. Rather it means the sum of invoices’ amounts for that customer under a particular 
Loyalty Program scheme. 
 
Redeeming Points 

• Continuing from the above example where we have created 1 invoice and earned 10 
points over it, we create another invoice by duplicating the first, and under the collapsible 
section for Loyalty Program, we check the checkbox for Redeem Loyalty Points. 

• The fields for Loyalty Point, Redemption Account and Redemption Cost Center will 
become visible under this section. The account and cost center will be fetched from 
the Loyalty Program assigned to the Customer. 

• Since we have earned 10 points, we can use as many of them as we want. If we try to use 
more than what we have an error will be thrown. 
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• For this example, we'll use all 10 points to be redeemed. Doing so will enable another field 
which will display the amount calculated using (loyalty point * conversion factor). So 
basically, 10 INR will be lessened from our outstanding amount. 

• When submitted, 2 Loyalty Point Entry will be created. One for redeemed, which will be a 
negative value and one for the current invoice (as the amount is still eligible under a tier). 

Note: For an invoice on which points have been earned, if a return invoice is created, it will 
delete the original Loyalty Point Entry and create a new one after subtracting the original 
amount with the returned amount. Also, when cancelling an invoice, its subsequent Loyalty 
Point Entry will also be deleted. 
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5. Budgeting 

In ERP+, you can set and manage budgets against a cost center or a project. This is useful in 
controlling your expenses. 

For example, if you are doing online sales, you can set a budget for search ads, and configure 
ERP+ to stop or warn you from over spending beyond the budget set. 

Budgets are also great for planning purposes. When you are making plans for the next financial 
year, you would typically target a revenue based on which you would set your expenses. Setting 
a budget will ensure that your expenses do not get out of hand, at any point. 

Cost Center 
To create new Cost Center, go to: Accounts > Budget and Cost Center > Chart of Cost Center > 
Add New Cost Center 

 

Project 
To create new Project, go to: Projects > project > Add New Project 

Setting a budget 
Step 1: Create a new Budget 
To define a Budget, go to: Accounts > Budget and Cost Center > Budget > New 

Step 2: Select Cost Center or Project 
In the Budget form, select a Cost Center or a Project. Budgets can be defined against any Cost 
Center, whether it is a Group / Leaf node in the Chart of Cost Centers. 

Step 3: Select Account 
In the Budgets table, select Income / Expense account for which budget is to be defined. 
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Step 4: Monthly Distribution 
If you have seasonal business, you can also define a Monthly Distribution record, to distribute 
the budget between months. If you don't set the monthly distribution, ERP+ will calculate the 
budget on yearly basis or in equal proportion for every month. 

 

Step 5: Control Actions (Alerts) 
Control actions can be triggered while material request is being submitted, purchase order is 
being submitted or while actual expense is being posted (through a journal entry or a purchase 
invoice). 

There are three types of control actions. 

• Stop: This will not allow users to submit the transaction. 
• Warn: This will show a warning message but lets the user to submit the transaction. 
• Ignore: This will neither prevent the user from submitting transaction nor show an error 

message. 

You can set separate action for monthly and annual budgets. 
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Budget Variance Report 
At any point of time, user can check Budget Variance Report to analyze the actual expense 
incurred vs budget allocated against a cost center or a project. 

To check Budget Variance report, go to: Accounts > Budget and Cost Center > Budget Variance 
Report 
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6. Auto Repeat 

Auto Repeat feature helps you create certain transaction automatically in a given time period. 

Use Case 
Assuming that you follow deferred expense system for some items. It requires you to create 
same Journal Entry each month to Cr. Deferred Expense a/c to Dr. Expense Account. You can 
create first Journal Entry manually for it, and then create auto-repeat transaction for it. 

Auto Repeat 
To set the subscription for the sales invoice Go to Subscription > select base doctype "Sales 
Invoice" > select base docname "Invoice No" > Save 

From Date and To Date: This defines contract period with the customer. 

Repeat on Day: If frequency is set as Monthly, then it will be day of the month on which 
recurring invoice will be generated. 

Notify by Email: If you want to notify the user about auto recurring invoice. 

Print Format: Select a print format to define document view which should be emailed to 
customer. 

Disabled: It will stop to make auto recurring documents against the subscription. 

Difference between Subscription and Auto Repeat 
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7. Subscription 

If you offer a service which requires renewal in the certain time period (yearly, monthly, 
quarterly etc.), you can use Subscription feature to track them. Subscription master captures 
all the details required for the auto-creation of Sales Invoice on subscription expiry. 

Let's consider a use-case of ERP+ subscription itself. Our hosting plans are available on yearly 
basis. Each customer's account has subscription expiry date, after which customer must renew 
their subscription with us. 

To manage client's subscription expiry and auto-generation of Sales Invoice for the renewal, 
we use Subscription feature. 

Subscription Validity 
Start Date: Day from when the subscription will be valid. 

Days Until Due: Enter no. of days for which subscription will be valid. 

Based on the subscription start and end date, actual dates for invoices will be calculated. 

Subscription Plan 
The subscription plan is linked to an Item, for which Sales Invoice is created. 

 

Taxes 
Select Taxes and Charges which will be applicable in the Sales Invoice created against this 
Subscription. 
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Discounts 
Mention discounts if any which will be applied on this particular subscription. 

Difference Between Subscription and Auto-Repeat 
Before Subscription feature was added in ERP+, the current Auto-Repeat feature was available 
as a Subscription only. 

The Auto-Repeat feature which is applicable for multiple transactions like Sales Order, 
Purchase Order, Invoices, Journal Entry etc. Whereas based on Subscription, only Sales 
Invoices are auto-created. 

Disabled: It will stop to make auto recurring documents against the subscription. 



 

 

 

 

 

 

 

 

 

1.8 Topic: Shareholder Management 
 

1. Shareholder 
2. Share Transfer 
3. Share Reports 

 



1. Shareholder 

ERP+ allows you to keep a track of all your Shareholders and maintain Share Transfers, Share 
Ledger and Share Balances. 

A shareholder is any person, company or other institution that owns at least one share of a 
company’s stock. Because shareholders are a company's owners, they reap the benefits of the 
company's successes in the form of increased stock valuation. If the company does poorly, 
however, shareholders can lose money if the price of company stock declines. 

A shareholder is uniquely identified by the Shareholder ID. Normally this ID is a naming series 
starting with 'ACC-SH-'. Also, as soon as the Shareholder makes even a single transaction, a 
Folio number is allocated to him. This also is a unique to the Shareholder. 

1. How to create a Shareholder 

1. Go to: Accounts > Share Management > Shareholder > New. 
2. Enter name of the Shareholder. 
3. Enter contact details etc. 
4. Save. 

 

A Shareholder can avail the features (operations) in the Share Transfer process. 



Note: Shareholders are separate from Contacts and Addresses. A Shareholder can have 
multiple Contacts and Addresses. 
 
Contacts and Addresses 
Contacts and Addresses in ERP+ are stored separately so that you can attach multiple Contacts 
or Addresses to Shareholders, Customers and Suppliers. 

  



2. Shareholder Transfer 

There may be times when you want to change the share structure of your company; either by 
adding a new shareholder or by changing the existing proportion of shares between 
shareholders. A share transfer is the process of transferring existing shares from one person to 
another; either by sale or gift. 

1. How to create a Share Transfer 

1. Go to: Accounts > Share Management > Share Transfer. 
2. Select the Transfer Type, for first ever Shareholder transaction this will be 'Issue'. 
3. Set a date for the transfer. 
4. Select the from and to shareholders. 
5. Select the from and to folio numbers. 
6. Set an account. 
7. Select the share type whether preference or equity. 
8. Select the number of shares to be transferred. 
9. Select the from and to number of shares. 

10. Set the rate of one share, the amount will be calculated based on number of shares. 
11. Save and Submit. 

Note: Before you can Purchase or Transfer shares between shareholders, shares need to be 
issued. 

 

  



3. Share Reports 

There are two types of reports you can view for shares. Share Balance and Share ledger. 

1. Share Balance 
This is a report view which gives the list of all the shares held by a given Shareholder and its 
value. Go to: Accounts > Share Management > Share Balance 

 

 

2. Share Ledger 
This is a report view which gives the list of all the transactions made by a given Shareholder. Go 
to: Accounts > Share Management > Share Ledger. 

 

 



 

 

 

 

 

 

2.1 Article: Record Entries 
 

1. Difference Entry Button 
2. Freeze Accounting Entries 
3. Post Dated Cheque Entry 
4. Adjust Withhold Amount Payment Entry 
5. Bulk Payment Entry 
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1. Difference Entry 

As per accounting standards, debit in an accounting entry must be equal to credit. If not, system 
does allow submission of accounting transaction, thereby stops ledger posting. In ERP+, on 
saving accounting entry, system validates if debit and credit is tallying. 

 

To have entry balanced, you should one more row, select another account, and update 
different amount in it. Or you can add difference amount in one of the Account's row itself. 

On clicking 'Make Difference Entry' button, new Row will be added under Journal Entry 
Accounts table, with difference amount. You can edit that row to select appropriate Account. 

On selecting account under new row, debit and credit an entry will be tallying, and you should 
be able to submit Journal Entry correctly. 
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2. Freeze Accounting Entries  

To freeze accounting entries up to a certain date, follow below given steps. 

Step 1: Go to: Accounts > Setup > Accounts Settings 
Step 2: Set Date Set date in the Accounts Frozen Up to field. 

 

Now, the system will not allow to make any accounting entries before set date. If at all someone 
tries creating entries, system will show error message as below. 

 

You can still allow user with certain role to create/edit entries within accounts frozen date. You 
can set that Role in the Account Settings itself. 

 

3. Post Dated Cheque Entry 
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Post Dated Cheque is a cheque dated on future date. Party generally give post-dated cheque, 
as advance payment. This cheque would be cleared only when cheque date arrives. 

In ERP+, create Payment Entry for post-dated cheque. 

Step 1: New Payment Entry:  
To open new journal voucher, go to: Explore > Accounts > Payment Entry > New 

Step 2: Set Posting Date:  
Assuming your Cheque Date is 31st December, 2016 (or any future date). As a result, this posting 
in your bank ledger will appear on Posting Date updated. 

 

 

Note: Payment Entry Reference Date should equal to or less than Posting Date. 

Step 3: Save and Submit 
After entering required details, Save and Submit the Payment Entry. 

Adjusting Post Dated Cheque Entry 
You can adjust Post Dated Payment Entry against an invoice via Payment Reconciliation Tool. 

When cheque is cleared, i.e. on actual date on the cheque, you can update its Clearance Date 
via Bank Reconciliation Tool. 

In the Chart of Accounts, you might find value of this Payment Entry already reflecting against 
bank Account. You should check Bank Reconciliation Statement, a report in the account 
module to know difference of bank balance as per system, and actual balance in the bank's 
statement. 
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4. Adjust Withhold Amount in the Payment Entry 

Question 
Let's assume that outstanding against a Sales Invoice is 20,000. When client makes payment, 
they will only pay 19,600. Rest 400 will be booked under Withhold account. How to manage this 
scenario in the Payment Entry. 

Answer 
In the Payment Entry, you can mention Withhold Account in the Deductions or Loss table. 
Detailed steps below. 

Step 1: Setup Withhold Account 
Create a Withhold Account in your Chart of Accounts master: Accounts > Chart of Accounts' 

Step 2: Payment Entry 
To create Payment Entry, go to unpaid Sales Invoice and create click on Make Payment button. 

Enter Payment Amount: Enter Payment Amount as 19,600. 

 

Allocate Against Sales Invoice: Against Sales Invoice, allocate 20,000 (explained in GIF below). 

Add Deduction/Loss Account: You can notice that there is a difference of 400 in the Payment 
Amount and the Amount Allocated against Sales Invoice. You can book this difference account 
under Withhold Account. 
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Following same steps, you can also manage difference availed due to Currency Exchange 
Gain/Loss. 
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5. Bulk Payment Entry 

If you want to create a single payment entry adjusting against multiple invoices, follow the 
steps given below. 

• Make a "New Payment Entry". 
• Select a Party Type and Party. On selection of a Party, all the outstanding invoices will be 

fetched for that Customer/Supplier. 
• Enter the Payment Amount. 
• Allocate the amount against invoices/orders as needed. 
• Save and Submit Payment Entry. 



 

 

 

 

 

 

2.2 Article: Account Operations 
 

1. Changing Parent Account 
2. Withdrawing Salary from Owners Equity Account 
3. Common Receivable Account 
4. Freeze Account 
5. Round Off Account Validation 
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1. Changing Parent Account 

Chart of Account has hierarchical structure. Each account has a parent it is listed under. 

There are some accounts which are auto-created. For example, Account for Warehouse is auto-
created when new Warehouse is added in the system. These accounts are added under pre-
defined account ledger. Warehouse Account is always added under Stock Assets, under Current 
Assets. 

If you wish to place specific Account into another parent Account, you can achieve the same as 
below. 

1. Go to Chart of Account 
Accounts > Setup > Chart of Account. Click on Account for which Parent Account is to be 
changed. 

2. Edit Account 

 

3. Change Parent Account 
Search and select preferred Parent Account and save. 
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Refresh system from Help menu to experience the change. 

 

Note: Parent cannot be customized for the Root Accounts, like Asset, Liability, Income, Expense, 
Equity. 
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2. Withdrawing Salary from Owner's Equity Account 

Question 
After meeting with my accountant here in the US, I was informed that with my company being 
a sole member, I should not pay myself a salary that would hit the direct expenses account but 
instead should take a "draw" that hits the balance sheet and not the expenses. Can you please 
advise how I should set this up in ERP Next please? 

Answer 

1. Create an account for Owner's Equity under Liabilities if you already do not have. This 
account will be your investment in the business and the accumulated profits (or losses). 
It will have a "Credit" type balance. 

2. Create an account for Owner's Draws under Owner's Equity. 
3. Note that the balance of Owner's Draws will always be negative since you are reducing 

money from your total equity / profits. 

Example 
Example journal entry (using Journal Voucher in ERP+) for a withdrawal of $1000 would be: 

1. Credit Cash $1000 
2. Debit Owner's Draws $1000 

  



| Accounts | 2.2 - Account Operations 
 

3. Common Receivable Account 

As per the party model, a common receivable account called Debtor is auto-created. This is a 
default Receivable Account for all the Customers. 

 

If needed, you can also create a new receivable account and update in the Customer master. 

Question: Should I create separate Receivable Account for each Customer? 

Answer: You can, but it's not a recommend approach. If you want to create separate Receivable 
Account for each Customer for tracking receivable, then it not needed. You still view Account 
Receivable & General Ledger report for each Customer. 

Just like Debtors, for tracking payables, default account called Creditors is created under 
Account Payables. 
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4. Freeze an Account 

Once an Account is Frozen, you won't be able to use it any accounting transaction. Since this is 
a critical action, you need to explicitly define a Role who can set an Account as Frozen. You can 
define this Role in the Account Settings. 

Accounts > Account Settings 

To freeze an Account, go to Chart of Accounts, and edit an Account. 

 

If User has Role define in the Account Setting assigned, then he/she will be able to set an 
Account as Frozen. 
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5. Round of Account Validation Message 

Question 

When submitting an invoice, why does it ask for a Round Off Account? How to update it? 

 

Answer 

In the Purchase Invoice, Grand Total is calculated based on various calculations like: 

• Qty * Rate = Amount 
• Tax and other charges applied to each item 
• Discount applied to some or all the items 
• Multiplication with exchange rate, in case of multiple currencies 

As a result of multiple calculations, there could be some rounding loss in the final amount. This 
rounding loss is generally very marginal like 0.034. But for the accounting accuracy, has to be 
posted in the accounts. Hence, you need to define a default Round-Off account in the Company 
master in which such amount availed as a result of rounding loss can be booked. 

You need to create Round-off Account in the Chart of Accounts and update in the Company 
master. Steps here. 

• Accounts > Chart of Accounts 
• In the Chart of Account, check or create new Account under Expense > Direct Expense. 

Ignore if account for this purpose already existing 
• Come to Company master Account > Company 
• Open Company in which Round-Off account has to be updated. 
• In the Company master, scroll to Accounts Settings and select Round-Off account and 

Cost Center.  
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Once Round-Off account this updated in the Company master, then try to submit Purchase 
Invoice once again. 



 

 

 

 

 

 

2.3 Article: Advanced 
 

1. Differences of Total and Valuation in Tax and 
Charges 

2. Types in Tax Template 
3. Manage Foreign Exchange Difference 
4. How to Freeze Accounting Ledger 
5. Managing Transactions in Multiple Currency 
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1. Purchase Tax or Charges Categories 

Consider Tax or Charge field in Purchase Taxes and Charges master has three values. 

• Total 
• Valuation 
• Total and Valuation 

 

Let's consider an example to understand an effect of each charge type. We purchase ten units 
of item, at the rate of 800. total purchase amount is 800. Purchased item has 4% VAT applied on 
it, and INR 100 was incurred in transportation. 

Total: 
Tax or Charge categorized as Total will be included in the total of purchase transactions. But it 
will not have impact on the valuation of item purchased. 

If VAT 4% is applied on item, it will amount to INR 32 (at item’s-based rate is 800). Since VAT is 
the consumption tax, it should be added value of Purchase Order/Invoice, since it will be 
included in payable towards supplier. But it should not be added to the value of Purchased 
item. 

When Purchase Invoice is submitted, general ledger posting will be done for tax/charge 
categorized as Total. 

Valuation: 
Tax or charge categorized as Valuation will be added in the value of purchased item, but not in 
the total of that purchase transaction. 

Transportation charge of INR 100 should be categorized as valuation. With this, the value of 
purchased item will be increased from 800 to 900. Also, this charge will be not be added to the 
total of purchase transaction, because it your expense, and should not be reflected to the 
supplier. 
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Total and Valuation: 
Tax or Charge categorized as for Total and Valuation will be added in the valuation of item, as 
well as in the totals of purchase transactions. 

Let's assume that transportation is arranged by our supplier, but we need to pay transportation 
charges to them. In that case, for transportation charges, category selected should be Total and 
Valuation. With this, INR 100 transportation charge will be added to the actual purchase 
amount 800. Also, INR 100 will reflect in the total, as it will be payable for us towards supplier. 
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2. Types in Sales and Purchase Tax Template 

In the Sales Taxes and Purchase Taxes master, you will find a column called Type. Following a 
brief on a meaning of each Type and how you can use it. 

 

Actual: This allows you to enter expense amount directly. For example, Rs. 500 incurred for 
Shipping. 

On Net Total: If you want to apply any tax or charges on Net Total, select this option. For 
example, 18% GST applied to all the item in the Sales Order. 

On Previous Row Amount: This option helps you want to calculate tax amount calculated 
based on another tax amount. 

Example: Education Cess is calculated based on the amount of GST tax. 

On Previous Row Total: For each Tax row, a cumulative tax is calculated in the Total column. 
For the first row, total tax is calculated as Net Total + Tax amount at first row. If you want to 
apply a tax on the Total Amount of another tax row, then use this option. 

If you select Type as Previous Row Amount or Previous Row Total, then you must also specify a 
Row No. whose Amount or Total should be considered for the calculation. 
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3. Manage Foreign Exchange Difference 

In ERP+, you can create transactions in the foreign currency as well. When creating transaction 
in the foreign currency, system updates current exchange rate with respect to 
customer/supplier's currency and base currency on your Company. Since Exchange Rate is 
always fluctuating, on might receive payment from the client on exchange rate different from 
one mentioned in the Sales/Purchase Invoice. Following is the instruction on how to manage 
different amount avail in payment entry due to exchange rate change. 

Add Expense Account 
To manage currency difference, create Account Foreign Exchange Gain/Loss. This account is 
generally created on the Expense side of P&L statement. However, you can place it under 
another group as per your accounting requirement. 

 

Book Payment Entry 
In the payment voucher, update invoice amount against Customer or Supplier account, then 
update actual payment amount against Bank/Cash account. Add new row and select Foreign 
Exchange Gain/Loss to update currency difference amount. 

In the below scenario, Sales Invoice was made EUR, at the exchange rate of 1.090. As per this 
rate, Sales Invoice amount in USD (base currency) was $1000. 

One receipt of payment, exchange rate changed. As per the new exchange rate, payment 
received in the base currency was $1080. This means gain of $80 due to change in exchange 
rate. 

In case you incur loss due to change foreign exchange rate, then different amount about be 
updated in the debit of Foreign Exchange Gain/Loss account. Also, you can add another row to 
update another expense like bank charges, remittance charges etc. 
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4. How to Freeze Accounting Ledger 

If you want to discontinue using specific Account, you can freeze it. 

Account can be Frozen by the User having specific Role. This Role for set in the Account Settings, 
in the field "Role Allowed to Set Frozen Accounts & Edit Frozen Entries". 

Please check following steps to freeze an Account from the Chart of Accounts master. 

Step 1: Chart of Accounts 
To edit an Account, go to Chart of Accounts: Explore > Accounts > Chart of Accounts 

 

Click on Account in which Frozen Date is to be updated. 

Step 2: Set Account as Frozen 
In the Account form, you will find a field called Frozen. Set value in this field as 'Yes' 

 

Step 3: Save 
After update Save an Account. 
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On saving, this Account will be frozen and will not be selectable in any accounting transaction. 

Note: In future, if you want to make an accounting transaction against this Account, then you 
can unfreeze this account by setting values in the Frozen field as 'No'. 
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5. Managing Transactions in Multiple Currency 

In ERP+, transactions can be created in the base currency as well as in parties (customer or 
supplier) currency. If transaction is created in the party’s currency, their currency symbol is 
updated in the print format as well. 

Let's consider a Sales Invoice, where your base currency of a Company is USD and party 
currency in EUR. 

Step 1: New Sales Invoice 
Accounts > Documents > Sales Invoice > New 

Step 2: Select Party 
Select Customer from the Customer master. If default Currency is updated in the Customer 
master, same will be fetched in the Sales Invoice as well, as Customer Currency. 

Step 3: Exchange Rate 
Currency Exchange between base currency and customer currency will auto-fetch. 

 

Step 4: Update Details 
Update other details like Item, Taxes, Terms. In the Taxes and other Charges table, charges of 
type Actual should be updated in the Customer's currency. 

Step 4: Save and Submit 
Save Sales Invoice and then check Print Format. For all the Currency field (rate, amount, totals) 
Customer's Currency symbol will be updated as well. 
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Currency Exchange Masters 
If you have come to terms with party to follow standard exchange rate throughout, you can 
capture it by creating Currency Exchange Rate master. To create new Currency Exchange Rate 
master, go to: Accounts > Setup > Currency Exchange 

If system find Exchange Rate master for any currency, it is given preference over currency 
exchange rate. 
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1. Tracking Project Profitability using Cost Center 

To track expenses and profitability for a project, you can use Cost Centers. You should create 
separate Cost Center for each Project. This will allow you to. 

• Allocating budget on expense for Projects. 
• Tracking Profitability of Project. 

Let's check steps on how Project and Cost Center should be linked, and used in the sales and 
purchase transactions. 

Linking Project and Cost Center 
 

1.1 Create Project 

To create new Project, go to: Projects > Project > New 

 

1.2 Create Cost Center 

Since budgeting and costing for each Project will be managed separately, you should create 
separate Cost Center for each Project. 

To create new Cost Center, go to: Accounts > Setup > Cost Center 

1.3 Update Cost Center in the Project 

Update Cost Center in the Project master. 
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In the sales and purchase transactions, if Project is selected, then Cost Center will be fetched 
from the Project master. 

Let's check how this setting will affect your sales and purchase entries. 

2. Project and Cost Center in Sales & Purchase Transactions 

2.1 Project in the Sales Transactions 

In the sales transactions (which are Sales Order, Delivery Note and Sales Invoice), Project will 
be selected in the More Info section. On selection of a Project, respective Cost Center will be 
updated for all the items in that transaction. Cost Center will be updated on in the transactions 
which has Cost Center field. 

 

2.2 Project in the Purchase Transactions 
In the purchase transactions, Project is defined for each line item. This is because you can 
create a consolidated purchase entry for various projects. On selection of Project, its default 
cost center will auto-fetch. 

As per perpetual inventory valuation system, expense for the purchased item will be booked 
when raw-materials are consumed. On consumption of goods, if you are creating Material Issue 
(stock) entry, then Expense Cost (says Cost of Goods Sold) and Project's Cost Center should be 
updated in that entry. 
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3. Accounting Report for a Project 

3.1 Project-wise Profitability 

Since Project's Cost Center is updated in both sales and purchase entries, you can check Project 
Profitability based on report on Cost Center. 

Monthly Project Analysis 
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Overall Profitability 

 

3.2 Project-wise Budgeting 
You can define budgets against the Cost Center associated with a Project. At any point of time, 
you can refer Budget Variance Report to analysis the expense vs budget against a cost center. 

To check Budget Variance report, go to: Accounts > Budget and Cost Center > Budget Variance 
Report 

Delivery from Sales Invoice 

If you have items delivery and invoicing happening at the same time, you can create delivery 
from with Sales Invoice itself. Sales Invoice has field called Update Stock, just before Item 
table. If this field is checked, on submission of Sales Invoice, stock of Item will be deducted from 
selected Warehouse. 
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On checking Update Stock, Sales Invoice Item will show relevant fields like Warehouse, Serial 
No., Batch No., Item valuation etc. 

On submission of Sales Invoice, with general ledger posting, stock ledger posting will happen 
as well. 
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2. Exchange Rate Field Frozen 

In ERP+, you can fetch Exchange Rates between currencies in real-time, or save specific 
exchange rates as well. In ERP+, saved exchange rates are also referred as Stale Exchange Rate. 

In your sales and purchase transactions, if the field of Currency Exchange Rate is frozen, that is 
because the feature of allowing stale exchange rates in transactions is enabled. To you wish to 
make Currency Exchange Rate field editable again, then disable the feature of Stale Exchange 
Rate from: 

• Accounts > Setup > Accounts Settings 
• Uncheck field "Allow Stale Exchange Rates". 
• Save Account Settings 
• Refresh your ERP+ account 
• Check Sales / Purchase transaction once again 

 

After this setting, the Exchange Rate field in the transactions should become editable once 
again. 
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3. Fiscal Year Creation 

New Fiscal Year should be created each year, at the end of the current fiscal year. Creation of 
new Fiscal Year before its beginning has been automated in ERP+. 

Three days prior to the end of the current Fiscal Year, system checks if new Fiscal Year for the 
incoming year is already created. If not, then system auto-creates new Fiscal Year. 
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4. How to Customize Cash Flow Report 

As your chart of accounts begins to get more complex and reporting standards change and 
evolve, the default cash flow report might no longer suffice. This is because ERP+ might not be 
able to accurately guess the classification and purpose of all accounts in the charts of accounts. 
Another gripe you might have is the inability to adjust the report format to fit your needs. 

This will no longer be a problem because ERP+ now allows users to customize the cash flow 
report. 

Technical Overview 

Customization is made possible by the introduction of two new doctypes - Cash Flow Mapper 
and Cash Flow Mapping. Both doctypes contain the information required to generate a cash 
flow report. 

Cash Flow Mapping shows how accounts in your charts of accounts map to a line item in your 
cash flow report while Cash Flow Mapper gets all the Cash Flow Mappings that relate to the 
three sections of a cash flow statement. 

With this, you generate detailed cash flow reports to your requirements. This might not make a 
lot of sense but it will after we go through an example. 

Example 

Background information 
Let's assume we have a fictitious company for which we want to generate a cash flow report. 
This is what the cash flow report looks like at the moment:  
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We don't like the report for the following reasons: - The reporting format is too scant. - The 'Net 
Cash from Operations' figure is wrong 

Customization Process 
We want the Cash Flow Report to look something similar to the format in the images below: 
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Activate Customized Cash Flow Report 
Do this in Accounts Settings by checking the 'Use Custom Cash Flow Format' checkbox. This will 
cause ERP+ to only use your custom format for cash flow reports. 

After doing that, your cash flow report should look like this:  
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Move to the next section to build the report. 

Create Cash Flow Mappings 
For each line, we need to create a Cash Flow Mapping document to represent it. 

 

You can think of the Cash Flow Mapping as a representation of each line in the cash flow report. 
A Cash Flow Mapping is a child of a Cash Flow Mapper which will be explained later. 
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Let's start by creating Cash Flow Mappings that will represent the add back of non-cash 
expenses already recognized in the Profit or Loss statement. We want them to appear on the 
cash statement as: - Income taxes recognized in profit or loss - Finance costs recognized in 
profit or loss - Depreciation of non-current assets 

Start by opening a new Cash Flow Mapping form. 

The fields in the Cash Flow Mapping doctype are: - Name: This something to identify this 
document. Name it something related to the label - Label: This is what will show in the cash 
flow statement - Accounts: This table contains all the accounts which this line relates to. 

With this information, let's go ahead and create the Cash Flow Mapping Document for the line 
'Income taxes recognized in profit or loss' 

 

I have named it 'Income Tax Charge' and given it a label 'Income taxes recognized in profit or 
loss'. We want this line to reflect income tax charges from our profit or loss statement. The 
account where this happens in our chart of account is named 'Income Taxes' (an expense) so I 
have added 'Income Taxes' into the accounts table. If you have more accounts representing 
income tax expenses, you should add all of them here. 

Because Income Tax expense needs to be adjusted further in the cash flow statement, check 
the 'Is Income Tax Expense' checkbox. This is what will help ERP+ properly calculate the 
adjustments to be made. 

For best results, let parent accounts have child accounts that have the same treatment for cash 
flow reporting purposes because ERP+ will calculate net change of all children accounts in a 
situation where the selected account is a parent account. 

In the same way, I have created for the remaining two mappings. 
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Finance costs also need to be adjusted so make sure to check the 'Is Finance Cost' checkbox. 

 

Next let's add Cash Flow Mapping for items that show changes in working capital: - 
Increase/(decrease) in other liabilities - (Increase)/decrease in trade and other receivables - 
Increase/(decrease) in trade and other payables - VAT payable - (Increase)/decrease in 
inventory 
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Don't forget to tell ERP+ that these mappings represent changes in working capital by checking 
the 'Is Working Capital' checkbox. 

At this point we have created all the mappings necessary for the Operating Activities section of 
our cash flow statement. However, ERP+ doesn't know that yet until we create Cash Flow 
Mapper documents. We'll create Cash Flow Mapper documents next. 

Create Cash Flow Mappers 
Cash Flow Mappers represents the sections of the cash flow statement. A standard cash flow 
statement has only three sections so when you view the Cash Flow Mapper list, you will that 
three have been created for you named: - Operating Activities - Financing Activities - Investing 
Activities 

You will not be able to add or remove any of them but they are editable and can be renamed.  
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Open the Operating Activities Cash Flow Mapper so we can add the Cash Flow Mappings we 
have created. 

• Section Name: This is the heading of the section. 
• Section Leader: This is the first sub-header immediately after the profit figure. Relates 

only to Operating Activities Cash Flow Mapper 
• Section Subtotal: This is the label for subtotal in the cash flow statement section. Relates 

only to Operating Activities Cash Flow Mapper 
• Section Footer: This is the label for the total in the cash flow statement section. 
• Mapping: This table contains all the Cash Flow Mappings related to the Cash Flow 

Mapper. 

Now add all the Cash Flow Mappings you have created and Save. You should have something 
like this:  
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Refresh the cash flow statement and view the changes.  

 

Looks close to our requirements but we are not done yet. Create new mappings for 'Investing 
Activities' and 'Financing Activities' sections of the cash flow statement. 
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Here's what our cash flow statement now looks like:  
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5. How To Manage Subscriptions With ERP+ 

ERP+ now allows you to manage your subscriptions easily. A single subscription can contain 
multiple plans. At the same time, A single subscriber can also have multiple subscriptions. ERP+ 
also automatically manages your subscriptions for you by generating new invoices when due 
and changing the subscription status for you. 

Related Doctypes 

Subscriber 
Like its name suggests, the Subscriber Doctype represents your subscribers and each record is 
linked to a single Customer. 

 

Subscription Plan 
Each Subscription Plan is linked to a single Item and contains billing and pricing information 
on the Item. You can have multiple Subscription Plans for a single Item. An example of a 
situation where you would want this is where you have different prices for the same Item like 
when you have a basic option and premium option for a service. 
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Subscription Settings 
Subscription Settings is where you tweak the behavior of the Subscription Doctype. For 
example, you can set a grace period for overdue invoices from it. You can also elect to have a 
subscription cancelled if an overdue invoice is not paid after the grace period. 

 

Creating A Subscription 

To create a Subscription, go to the Subscription creation form Explore > Accounts > 
Subscriptions 

 

Select a Subscriber. 
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If you want to cancel a subscription at the end of the present billing cycle, check the 'Cancel At 
End Of Period' check box. 

Select the start date for the subscription. By default, the start date is today's date. (Optional). 

If you are giving the subscriber a trial, enter the Trial Period Start Date and Trial Period End 
Date. 

If your invoice is not payable immediately, you can set the number of days before the invoice 
will be due in the 'Days Until Due' field. 

If you require more than one unit of a plan, set it in the 'Quantity' field. For instance, a web 
developer is subscribed to your web hosting service. The developer buys a plan for each 
customer. Instead of having multiple subscriptions for the same plan, you can simply increase 
the quantity as needed. 

In the 'Plan' table, add Subscription Plans as required. You may have multiple Subscription 
Plans in a single Subscription as long as they all have the same billing period cycle. If the same 
Subscriber needs to subscribe to plans with different billing cycles, you will have to use a 
separate subscription. 

Select a Sales Taxes and Charges Template if you need to charge tax in your invoices. 

Fill the relevant fields in the 'Discounts' section if you need to add discounts to your invoices. 

Click Save. 

Subscription Status 
ERP+ Subscription has five status values: - Trialling - A subscription that is in trial period 
- Active - A subscription that does not have any unpaid invoice - Past Due - A subscription 
whose most recent invoice is unpaid but is still within the grace period - Unpaid - A subscription 
whose most recent invoice is unpaid and past the grace period - Canceled - A subscription 
whose most recent invoice is unpaid and past the grace period. In this state, ERP+ no longer 
monitors the subscription. 

Subscription Processing in The Background 
Every one-hour interval, ERP+ processes all Subscriptions and updates each for any change in 
status. It will create new invoices if need be. When an outstanding invoice is paid, ERP+ updates 
the subscription accordingly. 

Manually Updating Subscriptions 
Once you have saved a subscription, you can change the 'Days Until Due', 'Quantity', 'Plans', 
'Sales Taxes and Charges Template', 'Apply Additional Discount On', 'Additional Discount 
Percentage' and 'Additional Discount Amount' fields. 



| Accounts | 2.4 - Other 
 

Note that changing any of the values will reflect in newly generated invoices only. Previously 
generated invoices will not be changed. 

Cancelling Subscriptions 
To cancel a Subscription, simply click the 'Cancel Subscription' button. The subscription will 
update its 'Cancellation Date' field and the subscription will no longer be monitored. 

If you are cancelling an active subscription, an invoice will immediately be generated. The 
generated invoice will be on pro-rata basis by default. If you want ERP+ always create an invoice 
for the full amount, uncheck the 'Prorate' field in Subscription Settings. 

Restarting Subscriptions 
To restart a canceled subscription, simply click the 'Restart Subscription' button. Note the 
Subscription will empty its invoices table. Note that the invoices will still exist but the 
Subscription will no longer track them. The start date of the subscription will also be changed 
to the date the Subscription is restarted. The start of the billing cycle will also be set to the date 
the Subscription is restarted. 

Recalculating Subscriptions 
Sometimes, a Subscription's status might have changed but might not yet be reflected in the 
Subscription. You can force ERP+ to update the subscription by clicking 'Fetch Subscription 
Updates'. 

Subscription Settings 

Grace Period represents the number of days after a subscriber's invoice becomes overdue that 
ERP+ should delay before changing the Subscription status to 'Canceled' or 'Unpaid'. 

Cancel Invoice After Grace Period would cause ERP+ to automatically cancel a subscription if 
it is not paid before the grace period elapses. This setting is off by default. 

Prorate would cause ERP+ to generate a prorated invoice when an active subscription is 
canceled by default. If you would prefer a full invoice, uncheck the setting. 



 

 

 

 

 

 

2.5 Article: Reports and Errors 
 

1. Purchase Invoice Account Type Error 
2. Fiscal Year Error 
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1. Purchase Invoice - Account Type Error 

Question: On saving the Purchase Invoice, I am getting a validation message that Credit to 
Account must be a Balance Sheet account. 

 

Answer: On submission of a Purchase Invoice, payable is updated towards the Supplier. As per 
the accounting standards, Payable Account is aligned under Current Liability (credit side of 
Balance Sheet). 

The error message indicates that Account selected in the Credit To field doesn't belong to the 
Liability Group. Please ensure that Payable Account selected in the Purchase Invoice is located 
under Liability group. 
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2. Fixing Fiscal Year Error 

While creating any entry, system validates if dates (like Posting Date, Transaction Date etc.) 
belongs to Fiscal Year selected. If not, system through an error message saying: 

Date ##-##-#### not in fiscal year 

You are more likely to receive this error message if your Fiscal Year has changes, but new Fiscal 
Year still not set a default. To ensure new Fiscal Year is auto updated in the transactions, you 
should setup your master as instructed below. 

Create New Fiscal Year 

Only User with System Manager's Role Assigned has permission to create new Fiscal Year. To 
create new Fiscal Year, go to: Accounts > Setup > Fiscal Year 

Set Fiscal Year as Default 

After Fiscal Year is saved, you will find option to set that Fiscal year as Default. 

 

Default Fiscal Year will be updated in the Global Default setting as well. You can manually 
update Default Fiscal Year from: Setup > Settings > Global Default 
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Save Global Default, and Reload your ERP+ account. Then, default Fiscal Year will be auto-
updated in your transactions. 

Note: In transactions, you can manually select required Fiscal Year, from More Info section. 
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